Data Express 4.0

Front End Guide

Micro Focus
The Lawn
22-30 Old Bath Road
Newbury, Berkshire RG14 1QN
UK
http://www.microfocus.com

© Copyright 2009-2020 Micro Focus or one of its affiliates.

MICRO FOCUS, the Micro Focus logo and Data Express 4.0 are trademarks or registered
trademarks of Micro Focus or one of its affiliates.
All other marks are the property of their respective owners.
2020-01-30

ii

Contents
Front End Guide

................................................................................................. 5

General Features ................................................................................................................ 5
Considerations .................................................................................................................... 5
Getting Started with Data Builder ........................................................................................6
General characteristics of use ..................................................................................6
Starting the Data Builder module ............................................................................. 6
Work environment settings ....................................................................................... 7
Main functions - phase execution ........................................................................... 11
Menus .....................................................................................................................12
Main Window - Work with Data Stores ..............................................................................16
Window pages ........................................................................................................17
Column headings in the grid area .......................................................................... 24
Available grid operations ........................................................................................ 25
Work with Data Store Window ...........................................................................................25
Window contents .................................................................................................... 26
Assign an Application ID Window ..................................................................................... 31
Window contents - Assign Single ........................................................................... 31
Window contents - Assign Multiple .........................................................................31
Add to Combined Data Element Window ..........................................................................32
Combined data element requirements and limitations ........................................... 34
Available operations ............................................................................................... 34
Work with Classes .............................................................................................................35
Work with Classes window ..................................................................................... 35
Work with Machine IDs ..................................................................................................... 37
Work with Machine IDs window ..............................................................................38
Work with Companies ....................................................................................................... 39
Window contents .................................................................................................... 39
Available operations ............................................................................................... 40
Work with Application IDs ................................................................................................. 40
Window contents .................................................................................................... 41
Available operations ............................................................................................... 41
Work with Routines ........................................................................................................... 42
Window contents .................................................................................................... 42
Available operations ............................................................................................... 42
Work with Process IDs ...................................................................................................... 43
Window contents .................................................................................................... 43
Available operations ............................................................................................... 44
Work with Data Elements ..................................................................................................44
Window contents .................................................................................................... 45
Work with Jobs ..................................................................................................................51
Window contents .................................................................................................... 51
Available operations ............................................................................................... 53
Job creation ............................................................................................................53
Custom jobs ........................................................................................................... 73
New Custom Query Wizard ...............................................................................................74
Starting the New Custom Query wizard ................................................................. 74
Options ..............................................................................................................................74
Window contents .................................................................................................... 75
Available operations ............................................................................................... 76
File Properties ...................................................................................................................76
Window contents .................................................................................................... 76

Contents | 3

Available operations ............................................................................................... 78
Filter by Data Store ........................................................................................................... 78
Window contents .................................................................................................... 78
Available operations ............................................................................................... 80
Compare Layouts - Copybook ...........................................................................................80
Window contents .................................................................................................... 80
Available operations ............................................................................................... 82
Sample Graph - Data Sampling ........................................................................................ 82
Window contents .................................................................................................... 83
Show Synthetic Data Element Contents ........................................................................... 83
Window contents .................................................................................................... 83
Work with Copybooks ........................................................................................................84
Window contents .................................................................................................... 84
Distributed Loader .............................................................................................................86
Load from database ............................................................................................... 86
Load from file ..........................................................................................................87
Appendix A. Standard Mode ............................................................................................. 87
Architecture ............................................................................................................ 88
Database connection prerequisite ..........................................................................89
Appendix B. Client / Server Mode ..................................................................................... 89
Architecture ............................................................................................................ 90
Server connection prerequisite ...............................................................................90

4 | Contents

Front End Guide
The guide provides step-by-step instructions to help you analyze and handle modifications of the data
within the data sets and data stores of the applications running in your environment. With Data Express,
you can verify the integrity of data within databases of applications that are either developed internally or
purchased by external suppliers.
The scope of Data Express is to allow users to consult and maintain the Knowledge Base obtained to be
able to analyze their own databases with a simple user interface which highlights:
•
•
•

Copybooks associated with the data store (Data Express for z/OS only.)
The corresponding record layout
The distribution of values in the data elements

Data Express contains the following elements:
•
•

•

Setup processing in the mainframe environment that automatically identifies data-store traces.
An engine in the mainframe environment that submits jobs for file analysis and sampling functions. This
respectively allows you to verify and evaluate the integrity of data (or the jobs of other functions), such
as the data masking and test environment creation functions. (Data Express for z/OS only.)
The evaluation of results using Data Express on a PC.

This guide provides the product configuration procedures and indicates the steps required to analyze the
data stores that make up your application.

General Features
The principal functions of Data Express are to:
•
•
•
•

•

Perform consultation and maintenance functions to define the work area.
Schedule batch jobs to run on z/OS. (Data Express for z/OS only.)
List application files, with the possibility of applying selection filters with user-defined criteria.
Complete and/or selectively access all information available for the selected data store:
• Details of the record layout
• Selection of the data classes defined
• Display (also graphical) of data element contents
Perform consultation and maintenance functions to confirm the results of batch phases run on z/OS.
(Data Express for z/OS only.)

Considerations
Be aware of the following points about the Data Builder module for Data Express:
•
•
•

To use the Data Express for z/OS solution, you must have the correct license. Refer to the Installation
Guide for more details.
You do not need to analyze the sources of the programs in the application to use Data Express.
Data Express does not perform any operation capable of altering the analyzed data.
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Getting Started with Data Builder
This chapter provides an overview of the Data Builder module within Data Express. You should read it
before using the Data Builder module.

General characteristics of use
Data Express for z/OS can be used in either Standard or Client/Server mode, whereas Data Express for
Distributed Systems can only be used in Standard mode:
• Standard – Supports direct access to the data resident on RDBMS from your PC.
• Client/Server – Supports access to the data resident on RDBMS through the Data Express kbdeServer: a product based on a three-tier architecture where the second tier handles data transfer
optimization. Client/Server mode lets you access data over the Internet with the lowest amount of
administration necessary and the best utilization of network capacity.
Note: Client/Server mode can use the same functions as Standard mode without you having to install
additional software on your PC, such as the DB2 client or the Borland Database Engine (BDE).
For Data Express configuration information and instructions, see Appendix A. Standard Mode and
Appendix B. Client / Server Mode.
The following guidelines apply to windows and screen items within Data Express:
• The main window: [Work with Data Stores] cannot be closed except when exiting the module.
• Multiple MDI windows may be opened simultaneously.
• Right-click an item or area to view a list of applicable commands.
• The list layout in the Grid area can be customized by selecting which columns you want to show or hide,
by selecting column width and position, or by ordering columns by increasing or decreasing order.
These customizations are automatically saved in the registry so that they are applied the next time the
application is run.
Each list can be exported to a file (with several formats available) so that it can be manipulated within a
spreadsheet.

Starting the Data Builder module
To start Data Builder:
1. Click Start > All Programs > Micro Focus Data Express 4.0 > Data Builder- CS
Note: If you are using Data Express on Windows Vista and User Access Control (UAC) is enabled,
you must run Data Builder as Administrator.
2. Select the required database with which to launch the connection. By default, the highlighted item in the
list of available databases is the last database you connected to using the Data Builder module.
Note: To connect to the database for first time, you need your user ID and password.
3. Select the required schema.
The Data Builder - [Work with Data Stores] window appears:
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Tip: Once you are connected to a database, you can open and close a database from the [Work with
Data Stores] window by clicking File > Open or File > Close.

Work environment settings
This section describes the process of preparing a work environment or workspace. You must specify a
workspace to organize and sort data on the basis of a logical model. The creation of at least one machine
ID and one company for the work environment is required.
A Data Express detailed work environment comprises the following objects:
•
•
•
•
•

Machine Identifiers – a primary identifier for your working environment.
Companies – a secondary identifier for your working environment.
Application Identifiers – applications that use data.
Process Identifiers – routines needed by the product to read, analyze, and interpret the data of the
processed data stores.
Classes – data types that are used to classify the data processed by Data Express.

Machine identifier creation
You can create a new machine identifier or modify a previously defined one.
One application file (that is managed by Data Express) must be associated with at least one machine
identifier. This operation helps you enable a partial analysis of the data stores and a partial display of
information while using Data Express.
For more information on the individual fields, see Work with Machine IDs.
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Company creation
You can create a new company or modify a previously defined one.
One application file (that is managed by Data Express) must be associated with at least one company. This
operation helps you enable a partial analysis of the data stores and a partial display of information while
using Data Express.
For more information on the individual fields, see Work with Companies.

Application identifier creation
Data Express allows the definition of an Application Identifier. Using this function, you can create a new
Application Identifier or modify a previously defined one.
Application IDs can be associated with the data stores of applications managed by Data Express, so as to
enable a partial analysis of the data stores and a partial display of information while using Data Express.
For more information on the individual fields, see Work with Application IDs.

Default environment parameter settings selection
You can set default parameters for the environment, identified by the Machine ID and Company pair. The
main parameter, Output Date Format, indicates the format in which dates are displayed in Data
Express. For example:
•
•

DD/MM/YY or DD/MM/YYYY – day/month/year (year with 2 or 4 digits)
MM/DD/YY or MM/DD/YYYY – month/day/year (year with 2 or 4 digits)
Note: The Output Date Format parameter is valid for the whole environment and is therefore
independent of the Company parameter. To define or change this parameter, click Environment >
Work With Default Parameters.

Analysis parameter modification
Note: This section applies only for Micro Focus Data Express for z/OS.
Data Express includes a function that recognizes the file record image automatically. This function –
together with the possibility of analyzing the COBOL and PL/I copies – lets you automatically associate the
data store with the copybook describing it.
The applied algorithms are based on statistical analysis of the information. The information included in the
data stores is analyzed to indicate the type of data included in each byte.
The analysis algorithms are based on parameters, which can be modified to meet the specific
requirements of your database.
The analysis parameters include:
Analysis Option
Indicates the conditions under which a data store must be analyzed. For example:
•
•
•

Perform the analysis only if the data store has not been analyzed.
Perform the analysis if the data store has been analyzed but not associated.
Perform the analysis even if the data store has already been analyzed and associated.

Number of Records
Indicates the number of records to analyze to identify the record image. The larger the
number of analyzed records, the more accurate is the recognized record image.
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Note: If the number of records to analyze is increased, the time required
for the processing increases as well. The default value proposed is
normally an acceptable compromise. In many cases, the different data
elements included in the data stores may contain null values, such as a
low-value, blank value, or all 0 or 9 digits. As a result, we recommend you
increase the value of the Number of Records parameter to allow the
analysis of a significant number of values.
Sample Data
Indicates whether to perform the analysis of the first n records of the data store (leaving
the option blank), or to sample the records to be processed evenly within the data store.
Note: Record sampling increases the time required for processing, but we
recommend record sampling for those data stores, which include many
non-valued data elements within the first n records.
Copy Association
Indicates whether or not to associate the data store directly with the copybook describing
its trace. The association algorithm will only be executed on copybooks analyzed until the
copybook association is run. Therefore, we recommend you use this option only when the
whole packet of copybooks belonging to the application has been analyzed.
Tolerance
Specifies a percentage of tolerance between the length of the data store layout and that of
the copybook describing it.
Note: If you set this parameter to 0 (zero), these length values must
coincide. Setting a tolerance to a value different from zero may be useful
when ‘FILLER’ fields involving the use of a copybook layout longer than the
data store layout are used in the copybook.
DB2 Date External Format
Specifies the format of the DB2 DATE field. This information is required during verification
of values outside a validity range or in the identification of special values.
Note: During analysis, default values can be modified temporarily.

Default copy analysis parameter modification
Note: This section applies only for Micro Focus Data Express for z/OS.
The copybook analysis parameters include:
Analysis Option
Indicates the conditions under which a copybook must be analyzed. For example:
•
•
•

Perform the analysis only if the data store has not been analyzed.
Perform the analysis if the data store has been analyzed but not associated.
Perform the analysis even the data store has already been analyzed and associated.

Maximum Progressive of I/O Area
Specifies the maximum number of incongruent formats an I/O area can describe through
the REDEFINES clause (within COBOL copies) or the READDRESSING (within PL/I
includes) clause.
COBOL Decimal Separator
Specifies the decimal separator within the COBOL copybook.
Statements beginning in PL/I sources - Statements length in PL/I sources
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Specifies the source start column and the length of the source row within the PL/I
INCLUDES.
Note: During analysis, default values can be temporarily modified.

Database interface specification
Note: This section applies only for Micro Focus Data Express for z/OS.
A different default process identifier is loaded for each type of database. This identifier can be replaced if
appropriate.
Process identifiers guide Data Express through the processing modes of each database by providing the
following information:
Format type
Fixed (FB) or variable (VB) length format.
Access type used
Direct access to the database, access to its sequential unload (for example, DL/I database
unload, or DB2 table unload) or access to image-copybook files for DB2 databases.
Length of the sequential unload
Required only for the DL/I sequential unloads.
File identifier within the sequential unload
Required only for the DL/I sequential unloads.
Data record position within the sequential unload
Required only for the DL/I sequential unloads. For all the other types of databases, you can
leave the default value.
Data record length within the sequential unload
Required only for the DL/I sequential unloads.
Name of the I/O routine called for the reading of the database.

Database access modes
This section outlines, in a table, all the database access modes available in the different processing
phases.
Note: This section applies only for Micro Focus Data Express for z/OS.
The table is divided into the following main phases:
•
•
•
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Load Data Store Information
Data Store Analysis
Data Store Sampling

Data Store Type

Load File Information

Data Store Analysis

Data Store Sampling

DB2 (1)

Direct access / Sequential
unload

Direct access / Sequential
unload

Direct access / Sequential
unload

SEQ

Direct access / Sequential
copybook

Direct access / Sequential
copybook

Direct access / Sequential
copybook

GDG

Direct access / Sequential
copybook

Direct access / Sequential
copybook

Direct access / Sequential
copybook
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Data Store Type

Load File Information

Data Store Analysis

Data Store Sampling

VSAM

Direct access / Sequential
unload (REPRO)

Direct access / Sequential
unload (REPRO)

Direct access / Sequential
unload (REPRO)

DL/I

Sequential unload

Sequential unload

Sequential unload

Others (2)

Sequential unload /
Customized I/O routine

Sequential unload /
Customized I/O routine

Sequential unload /
Customized I/O routine

(1)

Data automatically acquires the column definitions.

(2)

Any other database, even from another operating system, can be managed in a sequential format. For
databases running with the same system of Data Express, a customized I/O routine can be written and
used for a direct access.
Note: The access to the file sequential copybook can use the disk and/or tape unit.

Process identifier and database types relationships
Note: This section applies only for Micro Focus Data Express for z/OS.
The following table describes process identifiers pre-loaded by Data Express:
Process Identifier

Access Type

Description

ADAUN

Unload File Access (DSNTIAUL)

ADABAS BY UNLOAD

DB2DA

DB Direct Access (output DSNTIAUL) DB2 DIRECT ACCESS

DB2IY

Image Copy (output UNLOAD)

DB2 BY UNLOAD OF ICOPY FULL

DB2UN

Unload File Access (DSNTIAUL)

DB2 BY UNLOAD

DLIHD

Unload File Access (DSNTIAUL)

DL/I BY UNLOAD HSSR

DLIUN

Unload File Access (DSNTIAUL)

DL/I BY UNLOAD

GENDA

DB Direct Access (output DSNTIAUL) VSAM,SEQ,GDG DIRECT ACCESS

GENUN

Unload File Access (DSNTIAUL)

VSMDA

DB Direct Access (output DSNTIAUL) VSAM DIRECT ACCESS

VSAM,SEQ,GDG BY UNLOAD

Main functions - phase execution
Note: This section applies only for Micro Focus Data Express for z/OS.
The main functions of Data Express can be expressed in phases executed in the following order:
1.
2.
3.
4.
5.
6.
7.

Copybook specification.
Copybook analysis.
Source specification.
Source analysis.
Data store specification.
Data store analysis.
Automatic file or copybook association.

Other phases provided by Data Express are:
1. Data element sampling.
2. Data class definitions and association with the data elements.

Front End Guide
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Note: Many of the phases involve the submission of jobs. After launching a job, you must wait for it to
complete before proceeding with the next phase.

Menus
This section describes the menus and common toolbars displayed in the [Work with Data Stores] window.

File menu
The File menu contains the following options:
Menu option

Description

Open

Opens a project.

Close

Closes a project.

Close Enterprise View Connection

Disconnects you from the Micro Focus Enterprise View
Database. This option is activated after using
Enterprise View relations).

Database-Schema

Indicates the name of the most recently opened
database.

Exit

Terminates the Data Builder module.

(view

Tools menu
The Tools menu contains the following option:
Menu option

Description

Options

Opens the Option window for setting the help language,
security options, Oracle options, filter settings, and
confirmation message options.

Environment menu
The Environment menu contains the following options:
Menu option

Description

Work with Classes

Opens the Work with Classes window for consultation
and data entry of classes which can be assigned to a
data element of the data store.

Work with Machine IDs

Opens the Work with Machine IDs window for
consultation and data entry of identifiers of machines to
which the data stores to be analyzed belong.

Work with Companies

Opens the Work with Companies window for
consultation and data entry of the companies which use
the database to be analyzed.

Work with Application IDs

Opens the Work with Application IDs window for
consultation and data entry of the application identifiers.

Work with Process IDs

Opens the Work with Process IDs window for
consultation and data entry of the process identifiers.

Work with Default Parameters

Opens the Work with Default Parameters window to
change the output date format.

View menu
The View menu contains the following options:
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Menu option

Description

View Data Stores by Structure

Displays the list of data stores on the Structure page.

View Data Stores by Classes

Displays the list of data stores on the Classes page.

View Data Stores by Copybook

Displays the list of data stores on the Assigned to Copy
page. This option is listed only in the Data Express for
z/OS solution.

View Data Stores by Sampling

Displays the list of data stores on the Sampling page.
This option is listed only in the Data Express for z/OS
solution.

View Data Stores by Data Changer

Displays the list of data stores on the Data Changer
page.

View Data Stores by Register Tables

Displays the list of data stores on the Register Tables
page.

Toolbar

Displays or hides the toolbar.

Status bar

Displays or hides the status bar.

Windows menu
The set of open windows can be organized according to the standard Windows arrangements. The
Windows menu contains the following options:
Menu option

Description

Tile Horizontally

Arranges all open windows from top to bottom.

Tile Vertically

Arranges all open windows from left to right.

Cascade

Arranges all open windows so that they do not overlap.

Minimize All

Minimizes all open windows with the exception of the
main window, [Work with Data Stores].

Arrange

Arranges all minimized windows.

Help menu
The Help menu contains the following options:
Menu option

Description

Contents

Opens online Help information for the product in the
language selected in the Options window.

Micro Focus SupportLine

Contains commands for connecting to Micro Focus
SupportLine for information or technical assistance.

Micro Focus Data Express - Home Page

Connects to the Micro Focus Data Express Web site.

About

Displays production information about the Data Builder
module.

Context menu
This section describes the options displayed in context (pop-up) menus.
Column sorting
A context menu to display a list of sort options can be displayed by right-clicking a column header.
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Note: All changes to the grid layout are saved in the Windows system registry. For example, groups ,
column width attributes, column order attributes , and column font and color information. However,
filtering and sorting preferences are not saved.
The column sorting context menu contains the following options:
Menu option

Description

Sort Descending

Sorts the list contents in a descending order. The same
result can be obtained by simply clicking the column
heading.

Sort Ascending

Sorts the list contents in an ascending order. The same
result can be obtained by simply clicking the column
heading.

Group by This Column

Groups the list according to the contents of the selected
column if the Group Panel has been enabled.

Remove This Column

Deletes the selected column.

Column Selector

Displays a Customize window that contains a list of
columns that have been removed previously. A column
can be restored by performing a drag-and-drop operation
to the desired position in the list. A column can be
removed from a list by performing a drag-and-drop
operation from the list to the Customize window.

Alignment

Aligns the content of the columns to the center, right, or
left as specified by the user.

Best Fit

Resizes the selected column to allow the content of each
record to be displayed. The same result can be obtained
by double-clicking the column's external margin.

Pick Color

Allows the color of the selected column to be changed.

Pick Font

Allows the font, font style, size, color, and script to be
changed.

Best Fit (All Columns)

Resizes all the columns from the list to allow the content
of each record to be displayed.

Notes:
•
•

Columns can also be sorted by clicking or performing a drag-and-drop operation on the column
heading.
Information displayed can be reduced by clicking a column heading, then typing the first letter of
the items you are interested in.

Grid functions
A context menu to display a list of functions for a grid can be displayed by right-clicking any place on the
grid.
Note: All changes to the grid layout are saved in the Windows registry. For example, groups , column
width attributes, column order attributes , and column font and color information . However, filtering
and sorting preferences are not saved.
The grid functions context menu contains the following options:
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Menu option

Description

Column Selector

Displays a Customize window that contains a list of
columns that have been removed previously. A column
can be restored by performing a drag-and-drop operation
to the desired position in the list. A column can be
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Menu option

Description
removed from a list by performing a drag-and-drop
operation from the list to the Customize window.

Best Fit (All Columns)

Resizes all the columns from the list to allow the content
of each record to be displayed.

Export to File

Exports the information to a file using one of the following
compatible formats:
•
•
•
•
•

Show Summary Footer

comma separated value (.csv)
Hyper Text Markup Language (.htm)
text (.txt)
Excel (.xls)
Extensible Markup Language (.xml)

Displays the summary footer beneath the grid. By
selecting a row and right-clicking the summary footer, a
context menu displaying arithmetic operations you can
perform on the selected row appears.
Note: Arithmetic operations are only possible on numeric
contents.
Possible arithmetic operations include:

Show Group Panel

Summary

Displays the sum of all quantities in the
column. This option is active only for
columns with integer or percentage values;
if the value of the cells in a specific column
are represented as a percentage their sum
does not always equal 100%.

Minimum

Displays the minimum value of all values in
the column. The option is active only for
columns with numerical values.

Maximum

Displays the maximum value of all values
in the column. The option is active only for
columns with numerical values.

Count

Displays the number of elements in a
column.

Average

Displays the arithmetic mean of all values
in the column. The option is active only for
columns with numerical values.

None

Specifies using no arithmetic operation on
a column.

Displays the column name by which data is grouped
above the grid. By dragging the column headers into this
window, a group hierarchy can be defined.
Note: If data is being grouped by column, a footer
panel is displayed beneath the grid for each group.

Filter Active

If enabled, lets you choose data to be displayed on the
grid: a downward arrow icon will appear in the column
headers.
Click an arrow to choose the data to be displayed on the
grid. This function lets you generate a personal filter.

Front End Guide
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Menu option

Description
Note: The time taken to display the window
increases with the number of records to be
loaded.

Main Window - Work with Data Stores
After starting Data Builder, the main window, [Work with Data Stores] appears.
This window provides a list of data stores cataloged by Data Express using different sets of search criteria,
including:
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Machine identifiers
Company names
Application identifiers
Data store types
Data stores with assigned classes (Multiple class Selection)
Data stores assigned to copybook (Only applicable for Data Express for z/OS)
Data stores not assigned to copybook (Only applicable for Data Express for z/OS)
Data stores to be sampled
Data stores sampled
Data stores with sampling inactivated
Data stores with sampling activated
Data stores with Data Changer activated
Data stores with Data Changer inactivated
Data stores set as Register Table
Data stores without Register Table attribute
You can select a tab to view data stores using a specific set of criteria as listed above. Each tab is
associated with different grouping criteria.

The list of displayed data stores can be further restricted by applying filters. Filters can be selected from
the context menu displayed by right-clicking the List of Data Stores grid, or by selecting the specific icons
displayed on the left-hand side of the screen.
In the Data Express for z/OS, the [Work with Data Stores] window comprises six tabular views:
•
•
•
•
•
•

16
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Structure
Classes
Assigned to Copy
Sampling
Data Change
Register Tables

In the Data Express for Distributed Systems, the [Work with Data Stores] window comprises five tabular
views:
•
•
•
•

Structure
Classes
Sampling
Data Changer

Note: Double-click a data store name in the grid to view detailed information.

Window pages
This section describes each tabbed page of the [Work with Data Stores] window.

Structure page
Root nodes

Description

Machine ID

Data stores are grouped by machine ID.

Company

Data stores are grouped by company ID.

Appl ID

Data stores are grouped by application ID.

File type

Data stores are grouped by type.

Data store groupings can be saved by right-clicking the left-hand side of the screen to display the context
menu, then clicking Add to Favorites.
•
•

All: Reverts to the initial setting and displays all the catalogued data stores.
Favorites: Displays the views you have saved.
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Classes page
Data stores containing data elements with associated classes.
Root nodes

Description

Multiple Class Selection

By dragging two or more classes into the appropriate
window, data stores showing both classes can be
selected.

Multiple class selections can be saved by right-clicking the left-hand side of the screen to display the
context menu, then clicking Add to Favorites.
•
•

All: Reverts to the initial setting and displays all the classes created.
Favorites: Displays the views you have saved.

Assigned to Copy page
Data stores assigned to copybook or data stores not assigned to copybook. (Data Express for z/OS only).
Use the icons to display a list of tables with assigned and non-assigned copybooks from the Assigned to
Copy page.
•
•

Assigned: Data stores with assigned copybooks.
Unassigned: Data stores without assigned copybooks.

Sampling page
Data stores sampled or not sampled. The Data Sampling function can be used to display the content of the
data elements or a sample of the values contained in the data elements with the number of occurrences for
each of them. The Data Sampling phase provides the following information:
•

Up to 1000 different values for each data element, with their frequency and the frequency of the 999
ranges defined by the 1000 values (standard sampling).
Fingerprints (compressed sampling). This is a visual representation of the statistical distribution, in a
compressed format, of the data element content.
The concise representation of the content of a data element depends on the nature of the data element:

•
•

•

•

The values of numeric data elements are divided into homogeneous groups differentiated by the
value of their first digit and the number of digits they include. This description preserves the general
representation of the values distributed in the data element.
The values of alphanumeric data elements are organized according to several criteria, including:
First character, value length, presence of numeric characters only, presence of alphabetic characters
only.

The number of values belonging to each class is stored for each of these criteria, which allows the data
element content properties to be preserved. If you want to process the compressed sampling, the minimum
and maximum values of each sampled data element can also be calculated.
To access the data sampling function, click the
Sampling) on the toolbar.
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tab or click

(View Data Stores by

Icon

Description

Activated

Data stores with data elements that have been sampled.

Deactivated

Data stores that contain no data elements with sampling
activated.

Sampled

Data stores that contain sampled data elements.
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Icon

Description

Not Sampled

Data stores that contain no sampled data elements.

The first two icons can be combined with the second two to give four different combinations.
The following options are accessed by right-clicking a selected data store in the Work with Data Stores
area on the Sampling page:
Option

Description

Open Selected Data Store

Displays a window, which shows all the objects
associated with the data store (Work with Data Stores
area).

Data Store Properties

Displays a window with all the information about the data
store.

Delete Selected Data Store

Starts a job and deletes highlighted data stores from the
Knowledge Base.

Work with Data Elements of the Selected Data
Elements

Displays the data element details window, filtered for the
currently selected data store.

Show Synthetic Data Element Contents

Shows the statistical distribution of values in graphical
form about the sampling of data elements within the
selected data store.

Schedule Jobs

Shows a submenu used to schedule jobs for the selected
data store. (Data Express for z/OS only).

Enable/Disable Sampling

Enables and disables the sampling function.

Export to File

Exports the list of displayed data to a file of the chosen
type.

Filter Active

Independently of the data store selected, applies
selections to the list of data stores.

Data Changer page
The Data Changer function is a function of the Data Builder module that enables you to manage the
privacy of the data contained in the database of a specified application.
In Data Express for z/OS, you generate a copybook applying data masking logic on the basis of exit
routines. Records of the original data store can be omitted in the copybook by specifying filtering user exit.
The Data Changer:
•
•

Provides a list of the application files having the Data Changer functions applied, which may be filtered
according to selection criteria defined by the user.
Accesses, completely and/or selectively, all the information available for the selected data store:
•
•
•

Details of the record layout.
Selection of the data classes defined.
Display (also graphical) data element contents.

For more information about the Data Changer, see the Data Masking Guide.
To access the Data Changer, click the
Changer) on the toolbar.

tab or click

(View Data Stores by Data
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Button bar
Use the icons below to display a list of tables from the Data Changer page:
Icon

Description
Activated: Data stores with Data Changer activated.

Deactivated: Data stores with Data Changer deactivated.

Column headings
The following list describes the columns listed in the List of data stores grid of the Data Changer page
from the Work with Data Stores area.
Note: The order and dimensions of the columns are saved by the application automatically so that
they are retained for the next time the application is run.
Data Store Name

Name of the data store.

Data Store Type

Identifies the data store type: DB2, DL/I, Sequential (SEQ), VSAM, GDG
ODBC, or ORA. Data stores are grouped by type.

Machine ID

Identifier of the machine. Data stores are grouped by machine ID.

Company

Company name. Data stores are grouped by company ID.

Record format

Name of the record format.

Application ID

Identifier (if it exists) of the application area the data store belongs to.
Data stores are grouped by application ID.

Number of Records

Number of records contained in the data store.

Record Length

Length in bytes of the record layout.

Date of Migration

Date on which the data store was migrated.

Number of Analyzed Records vNumber of records analyzed in the data store.
Unload Input Data Store Type Type of the Unload Input data store.
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Unload Input File Name

Name of the Unload Input data store.

Unload Input File Version

Version of the Unload Input store.

Format Selector

Exit-routine for recognizing formats.

Select Program

Selection program of the individual record.

Unload Output Data Store
Type

Type of the Unload Output data store.

Unload Output Data Store
Name

Name of the Unload Output data store.

Unload Output Data Store
Version

Version of the Unload Output data store.

Write Program for Output

Write program of the Output data store.
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Associated Copybook PDS

Name of the PDS, which contains the copybook associated with the file.
(Only applicable for Data Express for z/OS.)

Assigned Copybook Name

Name of the copybook associated with the data store. (Only applicable
for Data Express for z/OS.)

IO area Name

Name of the area (level 01) within the copybook associated with the
data store. (Only applicable for Data Express for z/OS.)

IO area Prg.

Progressive number of the area within the copybook associated with the
data store.(Only applicable for Data Express for z/OS.)

Copy Association Provider

Identifies who supplied the association information; PGM is information
obtained from batch processing, USR is information supplied by the
user. (Only applicable for Data Express for z/OS.)

Description

Any text associated with the data store.

Data Store Nickname

Internal name given to the data store.

Context menu
This section describes options you can access by right-clicking a selected data store in the Work with
Data Stores area from the Data Changer page.
Open the Selected Data
Store

Displays a window that shows all the objects associated with the data store
in a Work with Data Store window.

Data Store Properties

Displays a window with all the information about the data store. See
Properties- File.

Delete Selected Data Store Deletes information for the highlighted data stores from the Knowledge
Base.
Work with Data Elements
of the Selected Data Store

Displays the data elements details window, filtered for the currently
selected data store.

Show Synthetic Data
Element Contents

Shows information in graphical form about the sampling of data elements
within the selected data store.

Schedule Jobs

Shows a submenu used to schedule jobs for the selected data store. (Data
Express for z/OS only.)

Export to File

Exports the list of displayed data to a data store of the chosen type.

Filter Active

Independently of the data store selected, applies selections to the list of
data stores.

Properties- File
The Properties - File window is a tabbed view that displays all attributes for a selected data store.
To access the Properties - File window, display the Data Changer context menu and click Data Store
Properties. An example of the Properties - File window is shown below:
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The fields on the Changer Input page are:
Format selector

Exit routine for recognizing formats.

Select program

Selection program of the individual record.

Process ID

Process identifier.

Unload data store type

Type of the Unload Input data store.

Unload data store name

Name of the Unload Input data store.

Unload data store version

Version of the Unload Input data store.

The fields listed on the Making Output page are:
Write program

Write program of the output file.

Unload data store type

Type of the Unload Output data store.

Unload data store name

Name of the Unload Output data store.

Unload data store version

Version of the Unload Output data store.

Register Tables page
The Register Tables page shows the environment files divided into two subsets: Register Table files and
Other Table files.
When data stores are loaded into the environment, they are initially all stored in theOther Table category.
If, during the sampling phase, a data store contains at least one data element containing all different
values, the tool considers this data store to be a register table file, and stores it in the Register Table
subset.
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You can use the specially provided commands to modify this subdivision at any time. The splitting up into
Register Table files and Other Table files has mainly been introduced for the Data Subset Extraction
(DSE) module.
The DSE function helps you create methodologies for the automatic generation of complete or reduced test
environments starting from an existing environment and on the basis of selection criteria entered by the
user. Additionally, the function lets you apply data masking logic during the generation of new
environments, including:
•
•
•

Integral test environment
Reduced test environment
Migrated environment

For further information on the Data Subset Extraction function, refer to the Data Subset Extraction Guide.
To access this function, click the
Tables) on the toolbar

tab or click

(View Data Stores by Register

Button bar
Use the icons below to display a list of data stores from the Register Tables page:
Icon

Description
Register Tables: Data stores set as register tables.

Other Tables: Data stores that do not have the Register Tables flag
activated.

Automatically Provided: Data stores that have been automatically
assigned this characteristic during the sampling phase. (Data Express for
z/OS only).

Provided By The User: Data stores that have been manually assigned this
characteristic.

The first two icons can be combined with the second two to give four different combinations.
Context menu
This section describes commands listed by right-clicking a selected data store in the Work with Data
Stores area from the Register Tables page.
Open the Selected Data
Store

Displays a window showing all the objects associated with the data store
(Work with Data Store window).

Data Store Properties

Displays a window with all the information about the data store.
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Delete Selected Data Store

Deletes information for the highlighted data store from the Knowledge
Base.

Work with Data Elements of
the Selected Data Store

Displays the data element details window filtered for the currently
selected data store.

Show Synthetic Data
Elements Contents

Shows information in graphical form about the sampling of data
elements within the selected data store.

Schedule Jobs

Shows a submenu used to schedule jobs for the selected data store.
(Data Express for z/OS only.)

Set as Register Table

Manually sets the data store as Register Table.

Set as Not Register Table

Manually sets the data store as Other Table.

Export to File

Exports the list of displayed data to a file of the chosen type.

Filter Active

Independently of the selected data store, applies selections to the list of
data stores.

Custom Query page
The Custom Query tab appears only after a custom query has been created. To create a custom query,
see New Custom Query Wizard.

Column headings in the grid area
The Grid area is on the right-hand side of each tab. The following list describes the column headings in the
Grid area for data stores that have been loaded in the Data Express Knowledge Base:
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Machine ID

Identifier of the machine.

Company

Name of company.

Data Store Name

Name of the data store.

Data Store type

Type of data store. For example, DB2, VSAM, DL/I, GDG, SEQ, GDG
ODBC, or ORA.

Record format

Name of the record format.

Application ID

Identifier (if it exists) of the application area the data store belongs to.

Associated Copybook
PDS

Name of the PDS that contains the copybook associated with the data
store. (Applicable only for Data Express for z/OS.)

Assigned Copybook
Name

Name of the copybook associated with the data store. (Applicable only for
Data Express for z/OS.)

IOarea Name

Name of the area (level 01) within the copybook associated with the data
store. (Applicable only for Data Express for z/OS.)

IOarea Progr

Progressive number of the area within the copybook associated with the
data store. (Applicable only for Data Express for z/OS.)

Description

Brief description of the data store.

Copy Association
Provider

Supplier of the association information. PGM is information obtained from
batch processing, USR is information supplied by the user.

Number of Records

Number of records contained in the data store.

Record Length

Length in bytes of the record layout.

Date of Last Calculation

Date of the last calculation run on the data store.
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Date of Last Sample

Date of the last calculation of the distribution of values of the data elements
of the data store involved in that process.

Date of Analysis

Date of the analysis carried out on the data store.

Number of Analyzed
Records

Number of records analyzed in the data store.

File Nickname

Internal name given to the data store.

Sampling

Indicator of whether the Sampling function has been enabled.

Available grid operations
Right-click a table name in the grid to view a list of available commands as described below:
Note: Not all commands are available on all pages.
Open Selected Data Store

Displays the Work with Data Store window that shows all the objects
associated with the data store.

Data Store Properties

Displays a window listing data store information.

Assign an Application ID

Displays the Assign an application ID window where you can assign an
application ID to a single data store or assign multiple application IDs to
multiple data stores. Not available from the Data Changer page.

Delete Selected Data Store Deletes information for the selected data store from the Knowledge Base.
Work with Data Elements
of the Selected Data Store

Displays the Work with Data Elements window that shows data element
details, filtered for the selected data store.

Show Synthetic Data
Element Contents

Displays information in graphical form about the sampling of data elements
within the selected data store.

Schedule Jobs

Displays a submenu used to schedule jobs on the selected data store.
(Data Express for z/OS only.)

Enable Sampling or
Disable Sampling

Toggles the Sampling function on and off.

Set as Register Tables

Manually sets the data store as Register Table. This command is only
available from the context menu accessible from the Register Table page.

Reset as Register Table

Manually sets the data store as Other Table. This command is only
available from the context menu accessible from the Register Tables page.

Work with Data Store Window
The Work with Data Store window provides information about the selected data store and all the objects
related to it. The information related to a data store includes:
•
•
•
•
•
•

The data elements in the data store.
The copybooks that describe the data store. (Applicable only for Data Express for z/OS.)
The classes assigned to the data elements.
The distribution of values in the data elements (spectrum).
The information about the data stores that have the Data Masking routines applied.
To access the Work with Data Store window, right-click a table in the Grid area (on the appropriate
page), and click Open Selected Data Store.
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Window contents
This section describes the fields and items listed in the Work with Data Store area as shown below:

The left pane contains a tree structure containing nodes with the available information about the opened
data store. The right-hand part of the screen shows a list of data linked to the selected node.
Note: The Parent Segment field appears for DL/I files and is an indicator of whether the data store is
a parent segment. (Data Express for z/OS only.)

Node pane
The root nodes are:
Data Elements Shows a detailed list of all the data elements of the data store, and shows summary
information in the data elements listed above the grid. This node does not contain sublevel nodes.

26

Associated
Copybook

Shows a detailed list of the copybooks that are compatible with the data store. This node
contains sub-level nodes, which are the copybooks. When a copybook is selected, a list
of fields is displayed, and summary information is displayed in the fields above the grid.
(Data Express for z/OS only.)

Assigned
Classes

Shows a detailed list of all the data elements of the data store associated with the class.
This node contains sub-level nodes, which are the associated classes. When a class is
selected, a list of fields is displayed, and summary information is displayed in the data
elements above the grid.

Sampling

Shows a detailed list of all data elements of the data store for which the sampling of the
values has been activated, and those for which the sampling of the values has been
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calculated at least once. This node contains sub-level nodes, which populate the fields
listed above the grid when selected.

Grid
The columns displayed in the Grid area depend on the node selected in the Node pane.
Data Elements columns
The following list describes the columns listed by selecting the Data Elements node:
Name

Name of the data element within the data store.

Displacement

Offset of the data element.

Physical Displacement Physical displacement of a DB2 field.
Note: Only DB2 fields use a Physical Displacement value.
Type

Data type of the data element. For example, Numeric or Alphanumeric.

Nature

Nature of the data elements, for example, Alphabetical.

Integer

Number of integers within a numeric data element.

Length

Length of the data element in bytes.

Decimal

Number of digits included to the right of the decimal point.

Assigned Class

Description of the associated class.

Estimated Class

Description of the most likely class to associate with the data element.

Minimum Value

Minimum value for the data element (result of data sampling).

Maximum Value

Maximum value for the data element (result of data sampling).

No. of Different Values Number of different values that the data element can take on. This is the
principal result of sampling the data store.
Associated Copybook columns
The following list describes the columns listed by selecting the Associated Copybook node. The
Associated Copybook node only applies to the Data Express for z/OS solution.
Machine ID

Identifier of the machine.

Company

Name of the company.

Copybook name

Name of the copybook (associated/compatible)

Copy PDS

Partitioned data set of the copybook.

I/O Area Name

Name of the associated area within the copybook (equivalent to level 01 of
COBOL copybooks or of PL/I includes).

I/O Area Progressive Progressive area number. If greater than 0 (zero), indicates the existence of
incongruent redefinitions of the area.
Deleted Flags

Logical deletion of the data store/copybook association

Record Length

Length of the record in bytes.

Number of Matches

Number of congruent bytes between the record layout of the data store and the
format of the copybook.
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Information Provider Origin of the information; PGM is supplied by batch process, USR is supplied by
user.
Associated Copy

An indicator of whether a copybook is associated with the data store (Yes, No).

Associated Copybook - CopybookName columns
Associated Copybook - CopybookName is a subnode of the Associated Copybook node.
Note: The Associated Copybook - CopybookName node only applies to the Data Express for z/OS
solution.
The following list describes the columns listed by selecting the Associated Copybook - CopybookName
node:
Name

Name of the field within the copybook.

Displacement

Position of the field within the layout of the copybook.

Level

Level of the field within the COBOL copybook or PL/I include.

Type

Type of copybook field. For example, Numeric or Alphanumeric.

Length

Length of copybook field in bytes.

Integer

Number of integer digits in the copybook field.

Decimal

Number of digits included to the right of the decimal point.

Sign

An indicator of whether the field is signed (Yes, No).

OCCURS Level

An indicator if the field is defined with recurrences.

Group

An indicator whether the field is of a group (Yes, No).

Assigned Classes columns
The following list describes the columns listed by selecting the Assigned Classes node:
Name

Name of the data element within the data store.

Displacement

The offset of the data element.

Physical Displacement The physical displacement of a DB2 field.
Note: Only DB2 fields use a Physical Displacement value.
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Type

Data type of the data element. For example, Numeric or Alphanumeric.

Nature

Nature of the data element, for example, Alphabetical.

Length

Length of the data element in bytes.

Integer

Number of integers within a numeric data element.

Decimal

Number of digits included to the right of the decimal point.

Assigned Class

Description of the associated class.

Estimated Class

Description of the most likely class to associate with the data element.

Minimum Value

Minimum value for the data element (result of data sampling). (Applicable only
for Data Express for z/OS.)

Maximum Value

Maximum value for the data element (result of data sampling). (Applicable only
for Data Express for z/OS.)
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No. of Different Values Number of different values that the data element can take on. This is the
principal result of sampling the data element. (Applicable only for Data Express
for z/OS.)
Sampling columns
The following list describes the columns listed by selecting the Sampling node. The Sampling node only
applies to the Data Express for z/OS solution.
Name

Name of the data element within the data store.

Displacement

The offset of the data element.

Physical Displacement The physical displacement of a DB2 field.
Note: Only DB2 fields use a Physical Displacement value.
Type

Data type of the data element. For example, Numeric or Alphanumeric.

Nature

Nature of the data element. For example, Alphabetical.

Length

Length of the data element in bytes.

Integer

Number of integers within a numeric data element.

Decimal

Number of digits included to the right of the decimal point.

Assigned Class

Description of the associated class.

Estimated Class

Description of the most likely class to associate with the data element.

Minimum Value

Minimum value for the data element (result of data sampling).

Maximum Value

Maximum value for the data element (result of data sampling).

No. of Different Values Number of different values that the data element can take on. This is the
principal result of sampling the data store.
Sampling – DataElementName columns
Sampling – DataElementName is a subnode of the Sampling node.
The following list describes the columns listed by selecting the Sampling – DataElementName node:
Field Value

Value assumed by the data element.

Occurrence No

Number of times the value in Field Value has been found.

Percentage

Percentage of the value over all the occurrences.

In-Range Occurrences In the complete sample, up to 1000 different values are recorded for each data
element. Each new value is considered within the range defined by the values
immediately above and below. This field indicates the occurrence within such
ranges.
Recalculation Date

Date of the last sampling.

Context menu
This section outlines the commands displayed in the context menu when selecting a data element in the
Work with Data Store area, and then right-clicking to display the context menu.
Note: All changes of the grid layout are saved in the Windows system registry. For example, groups,
column width attributes, column order attributes, and column font and color information. However,
filtering and sorting preferences are not saved.
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The data element context menu contains the following commands:
Zoom of the Synthetic Data
Element Content

Displays the window showing the Zoom of the distribution of the data
element values (provided that there are values sampled for the data
element).

Data Element Properties

Displays a window with summary information about the data store.

Show In Sampling

Displays a window showing the sampling results.

Set as Register Table Data
Element

Sets the selected data element as a Register Table data element.

Reset as Register Table Data Resets the selected data element as a Register Table data element.
Element
Add to Combined Data
Element

Displays the Add to Combined Data Element window where you can
define a new data element (which is a combination of multiple data
elements), after multiple data elements have been selected.

Data element properties
The Data Element Properties window displays all attributes for a selected data element.
To access the Data Element Properties window, display the context menu from the main window [Work
with Data Element] for a selected data element, and click Data Element Properties.
The following list describes the fields listed in the Data Element Properties window:
Name

Name of the data element within the data store.

Description

Data store description.

Type

Type of data element.

Nature

Nature of the data element. For example, Numeric or Alphanumeric.

Displacement

Field offset at the beginning of the I/O area. (Data Express for z/OS only)

Length

Length of data element in bytes.

Integer

Number of integer digits present.

Decimal

Number of decimal digits present.

Register Table Data
Element

Indicator of whether the data element is unique in the data store (Yes, No).

Data Element Sign

Indicator of whether the data element is considered as signed or not signed.

Variable Length

Indicator of whether the length of the data element is variable.

Justified

Indicator of whether the data element is justified.

Nullable Data Element

Indicator of whether the data element is set to NULL.

The buttons at the bottom of the fields in the Data Element Properties window are:
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Change

Initializes fields for insertion.

OK

Saves any changes that have not been applied and closes the window.

Cancel

Cancels any changes to the field properties and closes the window.
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Assign an Application ID Window
You can assign an application ID to a single data store or assign multiple application IDs to multiple data
stores.
Note: You can call the Assign an Application ID window from all pages on the [Work with Data
Stores] main window except the Data Changer page.
1. From the [Work with Data Stores] main window, select one or more data stores on the grid; then rightclick and select Assign an Application ID from the context menu.
2. Do either of the following:
To assign a single
application ID to all selected
data stores

From the Select an application ID drop-down list, select an
application ID; then click Apply.

To assign multiple
application IDs to multiple
files

1. Click Assign Multiple.
2. Using the drop-down list in the Application ID column for each
corresponding data store, select an application ID to associate
with each data store.
3. When finished, click Apply.

Window contents - Assign Single
Describes the fields and items that appear on the Assign an Application ID window for assigning a single
application ID to one or more data stores.

Select an application
ID

Lists all available application IDs that can be applied to the selected data store
or data stores.

Assign Multiple

Opens the Assign an Application ID window for assigning multiple IDs to
multiple selected data stores.

Apply

Applies the selected application ID to the selected data store or data stores.

Window contents - Assign Multiple
Describes the fields and items that appear on the Assign an Application ID window for assigning multiple
application IDs to multiple data stores. The following shows four example data stores:
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File Name

Name of the data store.

File type

Type of data store. For example, DB2, VSAM, DL/I, GDG, SEQ, GDG ODBC, or ORA.

Application ID

Identifier of the application area to assign to the corresponding data store.

Assign Multiple Opens the Assign an Application ID window for assigning a single application ID to
the selected data stores.
Apply

Applies the selected application IDs to their corresponding data stores.

Add to Combined Data Element Window
The Add to Combined Data Element window displays information about the combined data element you
are managing and the data store layout data element that comprise the combination. This window lets you
display, modify, or delete data element combination information.
A combined data element is essentially a “dummy” data element that you create to manage a combination
of different data elements that belong to the same data store.
To access the Add to Combined Data Element window, right-click one or more fields in the Grid area of
the Work with Data Store area and click Add to Combined Data Element.
An example of the Add to Combined Data Element window is shown below:
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Note: For more information about accessing the Work with Data Element area and the Data
Element context menu, see Work with Data Store Window.
For data subsetting only, the Advanced features window enables you to modify the contents of a data
element in a combined data element. For example, you can add prefix or suffix content to the data element
using character or hexadecimal values. In addition, you can substring a part of the data element, or supply
a routine that decides what the content of the data element should be (similar to a masking routine).
Note:
•
•
•
•

If you use a routine to define the data element contents, you cannot use other options.
All other options can be used together, if required.
Advanced features can only be used with data subsetting output classes, and cannot be used with
input classes.
Advanced features are available only with z/OS data stores.

An example of the Advanced features window is shown below:
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Combined data element requirements and limitations
Before data elements can be encompassed into a combined data element, they must be checked for
correctness. Each data element must meet the following requirements:
•
•
•

The data element is part of the data store that is being processed.
The data element is not a combined data element.
The data element is not a BIT data element.

There are limitations to the management of combined data elements as follows:
•
•

•

A previously defined combined data element cannot be inserted in the list of data elements.
There is a 230-digit limit to the length of the fields for sampling and subsetting operations. If you want to
perform these operations on longer combined data elements, you must develop some exit routines.
(Data Express for z/OS only.)
A combined data element can be masked only in Data Express for z/OS, in the following cases:
•
•

It is an MVS data element and its elementary data elements are consecutive, emulating the masking
of a group COBOL field.
It is an MVS data element with non-consecutive elementary data elements, does not exceed 255
bytes in the combined length, and the value of UR-OUT-TYPE in the masking routine is set to F (R is
not supported).

Available operations
The buttons at the bottom of the Add to Combined Data Element window are:
Refresh
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Refreshes the information. If another user defines a combined data element from a
different executable in the same database, you can see the changes.

Apply

Confirms the changes made to the combined data element. A newly created
combined data element appears as the last field in the List of Data Elements grid.

Delete

Deletes all information for the selected combined data element.

Cancel

Cancels any changes applied to the selected data element. Any actions confirmed
with the Apply button cannot be restored with Cancel but must be entered and
confirmed again.

Drag-and-drop
operations

Data elements listed in the List of Data Elements grid can be added to the List of
Data Elements grid by using a drag-and-drop operation.

Work with Classes
The Work with Classes area lets you manage classes by categorizing data element with homogeneous
characteristics and by writing generalized routines to check data.
A class identifies a user-defined group of data element with homogeneous characteristics. Typical classes
of data can be quantities, prices, client code, totals, or currency flags. Each data element can be cataloged
as a member of a class.
Note: The Data Builder module provides some predefined classes, which you can use but not modify.
Classes are grouped into sets called Super Classes. A Super Class gathers several different classes in a
single set. During the class automatic assignment phase, this type of classification enables you to restrict
the search for classes to a subset of all the defined classes.
The set of Super Classes is as follows:
•
•
•
•
•
•
•
•

Numbers (N)
Codes (C)
Date (D)
Complemented Date (9)
Descriptions (X)
Privacy (P)
Other (O)
None
Note: The Super Class Other is used for new user classes that may not fall into any of the previous
Super Classes. Conversely, the Super Class None is used for classes that do not belong to a Super
Class.

Date classes are defined by four available formats so you can run a formal check on the validity of the date
fields. For more information about the format of dates, see Getting Started With Data Builder

Work with Classes window
The Work with Classes window appears after clicking

(Work with Classes) from the main window.

The upper part of the window contains a list of classes, which is continuously updated according to the
functions performed. Below the list is a group of objects that map to all the data elements of the selected
class.
The following table describes the columns and fields listed in the Work with Classes area.
Note: If the corresponding Min and Max fields maintain their default values, the data range is ignored
and only the Data type value is considered.
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Field/Column Name

Description

Additional Information/
Requirements

Class ID

The Class identifier, which is a unique Mandatory field that is only editable
key for the file that records the
during class creation.
classes.
Note: Class IDs 9990-9999
are reserved for use by the
Data Subset Extraction
module to implement OR
conditions during subsetting.

Super Class

The Super Class that has been
associated with the class.

If the Super Class value has been
set to a space character, it indicates
that no Super Class has been
associated with the data element.

Name

The name of the class.

Mandatory field.

Charcode

The character identifier of the class.

Optional field.

Description

A brief description of the class. The
information in this column matches
the information in the Full
Description field.

Mandatory field.

Highlight

The primary class flag.

Optional field.

Edit Mask

The class editing mask.

Optional field.

Changer Program

The program which will be used when Optional field.
the class is assigned as a changer for
a selected field.

Data type

Allowed data type for the class.

Min Length

Allowed minimum length range for the This attribute is relevant only if you
use the associating data stores/
class. The default value is 0.
copybooks automatically function.

Mandatory field. This attribute is
relevant only if you use the
associating data stores/copybooks
automatically function. It is also used
by Data Subset Extraction.

Note: A check on the length is
only performed on nonnumeric classes.
Min Int

Allowed minimum number of integer
digits for the class. The default value
is 0.

This attribute is relevant only if you
use the associating data stores/
copybooks automatically function.
Note: A check on the length is
only performed on nonnumeric classes.

Min Dec

Allowed minimum number of decimal
digits for the class. The default value
is 99.

This attribute is relevant only if you
use the associating data stores/
copybooks automatically function.
Note: A check on the length is
only performed on nonnumeric classes.
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Field/Column Name

Description

Additional Information/
Requirements

Max Length

Allowed maximum length range for
the class. The default value is 0.

This attribute is relevant only if you
use the associating data stores/
copybooks automatically function.
Note: A check on the length is
only performed on nonnumeric classes.

Max Int

Allowed maximum number of integer
digits for the class. The default value
is 0.

The Min Int and Max Int values must
be specified if you receive the
message: “Error! Reference source
not found.”
Note: If the class is nonnumeric, this field is ignored.

Max Dec

Allowed maximum number of decimal This attribute is relevant only if you
digits for the class. The default value use the associating data stores/
copybooks automatically function.
is 99.
Note: A check on the length is
only performed on nonnumeric classes.

Name contains

Sequence of characters that data
elements associated with the class
must contain.

Optional field.

Name does not contain

Sequence of characters that data
elements associated with the class
must exclude.

Optional field.

Refresh button

Refreshes the class information.

If another user creates a class from a
different executable in the same
database, you can see the changes.

Apply button

Confirms the changes made to the class.

New button

Initializes fields for insertion when creating a new class.

Delete button

Deletes the selected class. Before a class can be deleted, a series of
referential integrity checks are carried out which, if not passed, generate an
error message and block the deletion.

Cancel button

Cancels any changes applied to the selected class. Any actions confirmed
with Apply cannot be restored with Cancel but must be entered and
confirmed again.

OK button

Saves any changes that have not been applied and closes the window.

Work with Machine IDs
The Work with Machine IDs area lets you perform consultation and data entry (insert, edit, and delete)
operations on classes. The insertion and edit data entry operations are stored. These operations carry out
a series of formal controls on the data element types. When deleting, however, checks are made on
referential integrity on the data stores, which depend on the machine identifiers.
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To access the Work with Machine IDs window, click

(Work with Machine IDs) from the main window.

Work with Machine IDs window
This section describes the columns and fields listed in the Work with Machine IDs window.
The upper part of the window contains a list of machine identifiers, which is continuously updated
according to the functions performed. Below the list is a group of objects that map to all the data elements
of the selected machine identifier. The following list describes the controls listed in the Machine IDs
window:
Control

Description

Field:
Machine ID

Identifier of the machine. This field uniquely identifies the
element and cannot be changed.

Description

Description of the machine identifier.

Model

Model of the machine.

Processor

Processor in the machine.

Insert Date

Date when the new machine ID was created.

Insert Time

Time when the new machine ID was created.

Button:
Refresh

The machine ID information. If another user creates a
machine ID from a different executable in the same
database, you can see the changes.

Apply

Confirms the changes made to the machine ID. Before
changes are applied, a series of checks on data elements
are performed; if the checks fail, the update is blocked.

New

Initializes fields for insertion when creating a new
machine ID.

Delete

Deletes the selected machine ID. Before a machine ID
can be deleted, a series of referential integrity checks are
carried out which, if not passed, generate an error
message and block the deletion.
Note: Before deleting a machine ID, any company
identifiers contained within it must be deleted in
the Work with Companies area. For more
information, see Work with Companies.
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Cancel

Cancels any changes applied to the selected machine
identifier. Any actions confirmed with Apply cannot be
restored with Cancel but must be entered and confirmed
again.

OK

Saves any changes that have not been applied and
closes the window.
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Work with Companies
The Work with Companies area lets you perform consultation and data entry (insert, edit, and delete)
operations on the companies cataloged by Data Express.
The insert and edit data entry operations are stored. These operations carry out a series of formal controls
on the data element types. When deleting, however, checks are made on referential integrity on the data
stores, which depend on the company identifiers.
A new company ID may be inserted only if an existing machine ID is selected. If a new machine ID is
required, it must be created from the Work with Machine IDs area. For more information about the Work
with Machine IDs area, see Work with Machine IDs.
To access the Work with Companies window, click

(Work with Companies) from the main window.

Window contents
This section describes the columns and fields listed in the Work with Companies window as shown
below:

The upper part of the window contains a list of companies, which is continuously updated according to the
functions performed. Below the list is a group of objects that map to all the fields of the selected company.
Machine ID

Identifier of the machine. This field uniquely identifies the element and cannot be
changed.
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Company Code

Company identifier. This field uniquely identifies the element and cannot be
changed.

Description

Description of the company identifier. The information in this column matches the
information in the Company Description field.

Insert Date

Date when the new company was created.

Insert Time

Time when the new company was created.

Life Cycle
Activated

Indicator of whether the Life Cycle is activated or deactivated.

Backup
Information

Information on the corresponding backup company including the Machine ID and
Company Code. If Is a Backup Company box is checked, the company is used by
the Life Cycle to save the old file information. To remove backup company
information, check Clear Company.

Record Limits

Specifies a limit to the number of records generated by Data Subset Extraction. If
this value is 0 (zero), normal subsetting rules apply. Otherwise, the value specified
is the number of records generated by the subsetting process.
Note: When Record Limits is specified at both the company and method
level, Data Express uses the method value.

Available operations
The buttons at the bottom of the Work with Companies area are:
Refresh

Refreshes the company information. If another user creates a company from a
different executable in the same database, you can see the changes.

Apply

Confirms the changes made to the company. Before changes are applied, a series
of checks on non-key fields are performed; if the checks fail, the update is blocked.

New

Initializes fields for insertion when creating a new company.

Delete

Deletes the selected company.

Cancel

Cancels any changes applied to the selected company. Any actions confirmed with
Apply cannot be restored with Cancel but must be entered and confirmed again.

OK

Applies the changes immediately and closes the window.

Clear Company

Clears the information on the associated backup company.

Analysis
Parameters

Launches the Define Analysis Parameters Wizard where copybook analysis
parameters can be defined.

Work with Application IDs
The Work with Application IDs area lets you perform consultation and data entry (insert, edit, and delete)
operations on the application IDs cataloged by Data Express.
The insertion and edit data entry operations are stored. These operations carry out a series of formal
controls on the data element types. When deleting, however, checks are made on referential integrity on
the data stores, which depend on the application identifiers.
To access the Work with Application IDs window, click
window.
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(Work with Application IDs) from the main

Window contents
This section describes the columns and fields listed in the Work with Application IDs area as shown
below:

The upper part of the window contains a list of application identifiers, which is continuously updated
according to the functions performed. Below the list is a group of objects that map to all the fields of the
selected element.
Application Identifier Identifier of the application.
Description

Description of the application identifier. The information in this column matches
the information in the Application ID Description field.

Insert Date

Date when the new application ID was created.

Insert Time

Time when the new application ID was created.

Available operations
The buttons at the bottom of the Work with Application IDs area are:
Refresh Refreshes the application identifier information. If another user creates an application identifier
from a different executable in the same database, you can see the changes.
Apply

Confirms the changes made to the application identifier. Before changes are applied, a series of
checks on non-key data elements are performed. If the checks fail, the update is blocked.
Note: Only the Application ID Description field can be modified.

New

Initializes fields for insertion when creating a new application identifier.

Delete

Deletes the selected application identifier. An application identifier can only be deleted if data
stores have not been cataloged for it by Data Express.

Cancel

Cancels any modifications made to the selected application identifier. Any actions confirmed
with Apply cannot be restored with Cancel but must be entered and confirmed again.

OK

Saves any changes that have not been applied and closes the window.
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Work with Routines
The Work with Routines area lets you perform consultation and data entry (insert, edit, and delete)
operations on the masking and subsetting routines by Data Express, allowing you to document the
masking and subsetting routine used in the project.
To access the Work with Routines window, click

(Work with Routines) from the main window.

Window contents
This section describes the columns and fields listed in the Work with Routines area as shown below:

The upper part of the window contains a list of routines, which is continuously updated according to the
functions performed. Below the list is a group of objects that map to all the fields of the selected element.
Routine Name

Name of the routine.

Routine Description

Description of the routine.

Routine Type

Type of the routine (masking or subsetting).

Available operations
The buttons at the bottom of the Work with Routines area are:
Apply

Confirms the changes made to the routine description.

New

Initializes fields for insertion when creating a new routine.

Delete Deletes the selected routine. A routine can only be deleted if it is not used by Data Express.
Cancel Cancels any modifications made to the selected routine. Any actions confirmed with Apply
cannot be restored with Cancel but must be entered and confirmed again.
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OK

Saves any changes that have not been applied and closes the window.

Work with Process IDs
The Work with Process IDs area lets you perform consultation and data entry (insert, edit, and delete)
operations on the process IDs cataloged by Data Express.
The Work with Process IDs window is available only in the Data Express for z/OS solution.
The insertion and edit data entry operations are stored. These operations carry out a series of formal
controls on the data element types. When deleting, however, checks are made on referential integrity on
the data stores, which depend on the process identifiers.
(Work with Process IDs) from the main window.

To access the Work with Process IDs window, click

Window contents
This section describes the columns and fields listed in the Work with Process IDs area as shown below:
The upper part of the window contains a list of process identifiers, which is continuously updated according
to the functions performed. Below the list is a group of objects that map to all the fields of the selected
element.
The following describes the general fields listed in the Work with Process IDs area:
Field

Description

Process identifier

Identifier of process. This field uniquely identifies the
element and cannot be changed.

Access type

Access type to be used:
•

Direct access to database, output in DSNTIAUL
format.

•

Direct access to database, output in UNLOAD format.

•

Access to sequential unload in DSNTIAUL format.

•

Access to sequential unload in UNLOAD format.

•

Access to sequential unload in UNLOAD by REORG
format.
Access to data set of full image-copy, output in
DSNTIAUL format.
Access to data set of full image-copy, output in
UNLOAD format.
Access to CA variable sequential unload, output in
DSNTIAUL format.

•
•
•
•

Access to CA comma delimited sequential unload,
output in DSNTIAUL format.

•

Access to CA external sequential unload, output in
DSNTIAUL format.

•

Access to CA fixed sequential unload, output in
DSNTIAUL format.

Record format

Format of the record (FB for fixed length format, VB for
variable length format).

Description

Description of the process identifier.
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Field

Description

I/O program name

I/O routine called for the reading of the database.

The following describes the general fields listed in the DL/I Attributes section of the Work with Process
IDs area:
Field

Description

Record Length

Length of sequential unload (record).

Data Position

Position of the data area within the sequential unload that
contains the information described in the copybook.

Record type position

Position of the data area within the sequential unload that
contains the segment name.

Record type length

Length of the data area within the sequential unload that
contains the segment name.

Type

Type of length value.

Position

Position of length value.

Length

Length of length value.

Note: The Data Length File Attributes fields provide information regarding the area, if one exists, of
the sequential unload that contains the length of the data area. If values are not specified, the
message “There is not enough information in the process identifier to retrieve the segment
record lengths” is reported, and Data Express assumes the data area has the maximum available
length (to the end of the physical layout).

Available operations
The buttons at the bottom of the Work with Process IDs area are:
Refresh Refreshes the process identifier information. If another user creates a process identifier from a
different executable in the same database, you can see the changes.
Apply

Confirms the changes made to the process identifier. Before changes are applied, a series of
checks on non-key data elements are performed. If the checks fail, the update is blocked.

New

Initializes fields for insertion when creating a new process identifier.

Delete

Deletes a selected process identifier. A process identifier can only be deleted if data stores have
not been cataloged for it by Data Express.

Cancel

Cancels any modifications made to the selected process. Any actions confirmed with Apply
cannot be restored with Cancel but must be entered and confirmed again.

OK

Saves any changes that have not been applied and closes the window.

Work with Data Elements
The Work with Data Elements area lets you implement the following functions:
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Associated page

Function

Select Data Elements

Find a list of data elements in the fastest and simplest
way possible.
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Associated page

Function

Classes - Assignment

Allow the data elements found to be associated with a
class after using appropriate filters.

Estimated Classes - Confirm

Confirm (or select from suggested alternatives) the class
obtained by the batch function executed for the automatic
cataloging of the data elements.

To access the Work with Data Elements window, click
window.

(Work with Data Elements) from the main

Window contents
This section describes the Work with Data Elements area as shown below:

Note:
The List of Data Elements grid appears a t the bottom of the window of all the pages.

Select Data Elements page
The Selected Data Elements page lets you filter the list of data elements by various attributes shown on
the following sub-pages:
•
•
•
•

Data Element Attributes
Naming Convention
Data Store Attributes
Data Element Class

Available Filters area
The Available Filters area (in the left-hand corner of the screen) is the set of principal filters used to define
the environment by the following fields:
•

Machine ID
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•
•
•

Company name
Application ID
Hide Data Elements
•
•
•
•

Assigned to Class – Hides data elements assigned to class.
NOT Assigned to Class – Hides data elements not assigned to class.
With Estimated Class – Hides data elements with estimated class.
Without Estimated Class – Hides data elements without estimated class.

Data Element Attributes page
The following list describes the fields listed on the Data Element Attributes page:
Data Element name

Allows selection by data element name.

Data Element type

Allows selection by data element type (Alphanumeric, Numeric, Packed,
Binary, Float, Edit Field, Time Stamp, Date, and Time).
Restriction: Data Express does not support LOB data element types for
DB2 and ADABAS databases. Also, some Binary data element types are
not handled during ADABAS FDT analysis.

Data element nature

Allows selection by data element nature (Alphabetical or Numeric).

Data Element length Allows selection by range of data element length.
Min/Max length

Allowed length range for the class.

Min/Max integer

Allowed integer digits for the class.

Min/Max decimal

Allowed decimal digits for the class.

Register Table Fields Allows selection based on the Register Table property.
Data Element Value

Allows selection based on the distribution of the data element contents.

Naming Convention page
The following list describes the fields listed on the Naming Convention page:
Data element name
contains

Allows selection of data elements whose names contain one of the strings
inserted in the list.

Data element name does
NOT contain

Allows non-selection of data elements whose names contain one of the
strings inserted in the list.

Data Store Attributes page
The following list describes the fields listed on the Data Store Attributes page:
DB2 Owner, DL/I DBD

Allows selection by file qualifier.

Data store name

Allows selection by data store name.

Data store type

Allows selection by data store type.

Data store version

Allows selection by data store version.

Data Element Class page
The following list describes the fields listed on the Data Element Class page:
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Super Class

Allows selection of all data elements that have an associated class of the same
category as the chosen Super Class (Number, Codes, Date, Complemented Date,
Description, and Other).

Assigned class Allows selection of data elements associated with a particular class.
Estimated class Allows selection of data elements associated with an estimated class.
By clicking Save Current Settings, views can be saved and restored at any time. Each view is given a
name, which differentiates it from the others. Double-click a name to display the corresponding view. Click
Delete Filter to delete a view.
Available operations
The buttons on the Select Data Elements page of the Work with Data Elements area are:
Refresh

Refreshes the window.

Clear Filters

Resets all the filter conditions setup in the different tabs.

Apply Filters

Applies all filters configured to the window.

Close

Closes the window.

Classes - Assignment page
The Class - Assignment page is used to assign a class to the data elements of the filtered list, supplying
detailed information related to both the class and data elements. Information on the page is divided into
two parts, where information linked to the classes appears on the left and to the fields on the right.
An example of the Class - Assignment page in the Work with Data Elements area is shown below:

All classes hierarchy
On the left the class tree is shown. The main branches are made up of Super Classes (Number, Codes,
Date, Description, Other) while the secondary ones are made up of the constituent classes.
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Class Attributes area
Selecting a class updates the corresponding attribute fields (Class Attributes):
Name

Class name.

Class ID

Class code.

Description

Description of the class.

Super Class

Name of the Super Class.

Code

Identifier code for the class.

Class Samples

Examples of distribution associated with the class.

The filtered list of fields is shown at the bottom. Selecting one of these updates the corresponding attribute
fields:
Selected Data Element Attributes – Data Element page
The fields listed on the Data Element page are:
Name

Name of the data element within the data store.

Type

Type of data element.

Nature

Nature of the data element (Numeric or Alphanumeric).

Displ

Position of the data element within the record layout.

Length

Length of data element in bytes.

Int

Number of integer digits.

Dec

Number of decimal digits.

Register Table Field

Indicator of whether the data element is a Register Table field.

Selected Data Element Attributes – Data Store page
The fields listed on the Data Store page are:
Name

Name of the data store.

Type

The type of data store.

Version

Version of the data store.

Number of Records

Number of records in the data store.

Selected Data Elements Attributes - General page
The fields listed on the General page are:
Machine ID

Identifier of the machine.

Company

Name of the company.

Application ID

Identifier of the application.

Selected Data Elements Attributes - Date page
The fields listed on the Date page are:
Recalculation Date
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Date of last recalculation.

Available operations
The buttons listed on the Classes - Assignment page of the Work with Data Elements area are:
Refresh

Refreshes the window.

Assign Class Assigns a class to a list of selected data elements. The steps are as follows:
1.
2.
3.
4.
Clear Class

Select the fields involved in the association from the List of Data Elements grid.
Click the Classes - Assignments tab.
Select a node on the class tree.
Click Assign Class.

Deletes the class associated with the list of selected data elements. The steps are as
follows:
1. Select the data elements involved in the disassociation from the List of Data
Elements grid.
2. Click Clear Class.

Close

Closes the window.

Estimated Classes - Confirm page
The Estimated Classes - Confirm page is used to confirm the class assignment proposals. On z/OS, this
is produced by the batch analysis. Information on the page is divided into two parts, where information
about proposed classes appears on the left and information about selected data elements on the right.
An example of the Estimated Classes - Confirm page in the Work with Data Elements area is shown
below:

Class Attributes area
On the left the list of classes proposed for the selected data element is shown. Selecting a class updates
the corresponding attribute data elements:
Name

Name of the class.
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Class ID

Class code.

Description

Description of the class.

Super Class

Name of the Super Class.

Code

Identifier code for the class.

Class Samples

Examples of distribution associated with the class.

The filtered list of data elements is shown at the bottom. Selecting one of these updates the corresponding
attribute data elements in the Selected Data Element Attributes area.
Selected Data Element Attributes area
Data Element page
The following list describes the fields listed on the Data Element page:
Name

Name of the data element within the data store.

Type

Type of data element.

Nature

Nature of the data element (for example, Numeric or Alphanumeric).

Displ

Position of the data element within the record layout.

Length

Length of data element in bytes.

Int

Number of integer digits.

Dec

Number of digits included to the right of the decimal point.

Register Table Field

Indicator of whether the data element is a Register Table field.

Data Store page
The following list describes the fields listed on the Data Store page:
Name

Name of the data store.

Type

Type of data store.

Version

Version of the data store.

Number of Records

Number of records in the data store.

General page
The following list describes the fields listed on the General page:
Machine ID

Identifier of the machine.

Company

Name of the company.

Application ID

Identifier of the application.

Date page
The following list describes the fields listed on the Date page:
Recalculation date
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Date of last recalculation.

Available operations
This section describes the functions of the buttons listed on the Estimated Classes - Confirm page of the
Work with Data Elements area:
Refresh

Refreshes the window.

Assign Class

Assigns a selected class to a data element. The steps are as follows:
1. Select the field involved in the association from the List of Data Elements grid.
2. Select the class to assign.
3. Click Assign Class.

Confirm Class Allows the most likely class to be assigned to a list of selected data elements. The steps
are as follows:
1. Select the fields involved in the association from the List of Data Elements grid.
2. Click Confirm Class.
Close

Closes the window.

Work with Jobs
The Work with Jobs area is used to schedule batch jobs to run on z/OS.
Note: The Work with Jobs area is available only the Data Express for z/OS solution.
Once the product setup phase is finished and a stable state is established, the Work with Jobs area lets
you work directly from a PC for both the scheduling of jobs and the consultation and maintenance of the
results obtained.
To access the Work with Jobs area, click

(Work with Jobs) from the main window.

Window contents
This section describes the Work with Jobs area as shown below:

Front End Guide

| 51

List of Jobs grid
The List of Jobs grid displays a fixed list of possible jobs to schedule.

List of Scheduled Jobs grid
The List of Scheduled Jobs grid displays a list of jobs that have been scheduled . Each scheduled job is
associated with a job state as indicated by the following icons:
Icon

Description

Status flag

Job still to be submitted

0

Job running

1

Job finished

9

Job not submitted

-x (negative digits)

Note: The Work with Jobs area lets you create a job without submitting it. You can submit a job later
by changing its job submission status from Job Creation to Job Submission.

Window fields
The following list describes the fields listed in various sections in the Work with Jobs area:
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Machine ID

Identifier of the machine.

Company name

Identifier of the company.

Copy PDS

PDS of copybooks/includes to analyze.

Copybook name

Name of the copybooks/includes to analyze.
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Job creation

Option for creating a new job without submitting it.

Job submission

Option for submitting a new job.

Application ID

Identifier of the application.

DB2 Owner, DL/I DBD Qualifier of the data store to analyze.
Data store type

Type of the data store to analyze (VSAM, DB2, DL/I, SEQ, GDG, ORA, SQE, or
ADA).

Data store name

Name of the data store to analyze.

Data store version

Version of GDG data store to analyze.

Record format

Record format to analyze.

Available operations
This section describes the buttons at the bottom of the Work with Jobs area.
Change Modifies a scheduled job. By selecting a scheduled job with status flag 0 (i.e. still to be
submitted), all the job submission parameters are updated in the lower part of the window. It is
possible to change all the parameters and then, after having introduced the changes, save them
to z/OS by clicking Apply. Before updating the list, a new window is displayed requesting
additional parameters.
Apply

Confirms the update/insertion data for a job to schedule.

New

Initializes all the field parameters. You can then insert the scheduling parameters of the new job.
To save to z/OS, click Apply. Before updating the list, a new window is displayed requesting
additional parameters.

Delete

Cancels a highlighted job. If this is being executed (flag status 1), you are prompted to confirm
the delete operation.

Cancel Cancels any changes made to the selected job. Any actions confirmed with Apply cannot be
restored with Cancel but must be entered and confirmed again.
OK

Saves any changes that have not been applied and closes the window.

Job creation
This section describes the basic procedure for creating a new job. The subsections address the secondary
parameters needed for creating specific jobs. The following guides discuss other jobs:
Life Cycle Guide

Data Masking Guide

Subset Extraction Guide

Life Cycle
Clear Life Cycle History
Data Store Data Changer
Create Data Changer Jobs
Test Environment Creation
Create Allocation Jobs
Create Unload Jobs
Create Reload Jobs
Create Extraction Jobs

To begin job creation:
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1.
2.
3.
4.
5.

Select the job from the List of Jobs grid.
Click New to initialize fields for insertion.
Select Machine ID and Company name from the corresponding lists.
Click Apply.
Follow the guidelines in the appropriate subsection for the job you want to create.
Note: The Reset All, Apply, and Cancel buttons are available in each Secondary Options
window.
Note: If your Data Express Knowledge Base is in on MVS but the described data is on a distributed
system – as an alternative to scheduling jobs using Work with Jobs – you can update the classes
and the method from the referential integrity interface in interactive mode just as you would for Data
Express for Distributed Systems. The interactive update is described in your Getting Started with
Distributed Data Stores guide, and can be activated if:
•
•

The version of DB2 is 8 or later.
The HSURDRIA table within the Data Express Knowledge Base only contains one record and this
record is set to Y. (This table must be populated by a DB2 administrator. Data Express does not
directly modify the table in order to prevent unwilled use of the interactive update from referential
integrity.)

Class Field Assignment job
Complete the values listed in the Secondary Options window for the Class Field Assignment job as
shown below:
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Sections and fields
Complete the values in the following sections and fields as appropriate:
Select a Class Selects a class from the list.
Super Classes Selects a super class.
Field Types

Selects type or combination of types.

Field Length

Gives minimum and maximum length of the field.

Rules

Group of data entry functions with the masking and reduction rules to be applied to an
environment.

Thresholds

Logical operations between Treshold1 and Treshold2.

Available operations
Use the Add and Delete buttons to add or delete a selected class.

Create Deletion Statements
Complete the values listed in the Secondary Options window for the Import Combined Data Elements
Information Create Deletion Statements job as shown below:
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Group

The group for which you want to create deletion statements.

Method

The method for which you want to create deletion statements.

From step

The first step in a range of steps defined in conjunction with the To step
parameter.

To step

The last step in a range of steps defined in conjunction with the From step
parameter.

Discard Unchanged
Files

From the deletion statements, discard all DB2 tables belonging to the current
method that are neither reduced nor masked.

JCL output data set

The library where generated SQL statements are stored.

JCL output member

The member in which generated SQL statements are stored.

Target DB2 owner

The owner of the target environment where the statement is to run.
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Important: Before executing the generated DDL:
1. Execute a method simulation.
2. Copy the ANENVLST table of the knowledge base into the target environment.

Create Format Selector job
Complete the values listed in the Secondary Options window for the Create Format Selector job as
shown below:

Format Selector
Name

The name of the format selector. It is a character field with a maximum length of 8
characters.

Position

The position of the record format. It is a 5-digit number.

Length

The length of the record format. It is a 3-digit number.

To better manage file names with format selector, KURFMT is available. Variables KURFMT-FILTYPE,
KURFMT-FILNAME and KURFMT-FILVER contain characteristics of the file when using Format Selector.
The following is an example of a Format Selector program using KURFMT:
…
COPY KURFMTW.
*****************************************************************
LINKAGE SECTION.
*****************************************************************
* INPUT
M50373*01 LK-RECORD
PIC X(16000).
M50373 01 LK-RECORD
PIC X(32760).
* OUTPUT
01 LK-FORMAT
PIC X(0010).
*****************************************************************
PROCEDURE DIVISION
USING LK-RECORD
LK-FORMAT.
*****************************************************************
*****************************************************************
*
SET
KURFMT-OP-READ TO TRUE.
CALL "KURFMT" USING KURFMT-AREA.
DISPLAY KURFMT-FILNAME

DB2 Catalog Synchronization job
Complete the values listed in the Secondary Options window for the DB2 Catalog Synchronization job
as shown below:
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DB2 Information Interface

Type of the DB2 interface.

Data Store / Copybook Relationship Analysis job
Complete the values listed in the Secondary Options window for the Data Store / Copybook
Relationship Analysis job as shown below:

Replace Association

Indicator of whethor an existing association will be replaced.

Tolerance

This parameter allows you to specify a percentage of tolerance between the
length of the data store layout and that of the copybook describing it. If you set
this parameter to zero, these length values must coincide. Setting a tolerance
to a value different from zero may be useful when ‘FILLER’ fields involving the
use of a copybook layout longer than the data store layout are used in the
copies.

Include also copy with
confidence in

Choose the range.

Copy - Machine ID

Select Machine ID from the list.

Copy - Company

Select the company from the list.

Data Store Data Element Sampling job
Complete the values listed in the Secondary Options window for the Data Store Data Element Sampling
job as shown below:
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Compressed sampling A processing of the compressed sampling is requested.
Min/Max calculation

The minimum and maximum values of each sampled field can also be
calculated.

Sampling Frequency

The frequency of the sampling execution (values from 1 to 5).

Standard sampling

Standard Sampling will be performed.

Additional field attributes can be chosen by clicking Advanced. An example of the window displayed is
shown below:
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Export Class Assignment Information
Complete the values listed in the Secondary Options window for the Export Class Assignment
Information job as shown below:
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Sequential
data store

Name of the data store containing the interface. Typically, it is a valid z/OS data store
name. If it is not a valid z/OS name, it is a mnemonic, and indicates that this sequential
data store should be placed in the knowledge base table HSURDINT rather than residing
on disk. In this case, the mnemonic sequential data store value is placed in the
HSURDINT.INTNAME column, so the contents of the data store within HSURDINT can be
easily identified in further processing.

Note: You can use the Export Class Assignment Information job to export data from one Data
Express instance to another by configuring the external interface output to use an alternative data
store name and DB2 qualifier. To configure the external interface output, edit the UURXEX program
provided with Data Express.

Export Classes Information
Complete the values listed in the Secondary Options window for the Export Classes Information job as
shown below:

Sequential
data store

Name of the data store containing the interface. Typically, it is a valid z/OS data store
name. If it is not a valid z/OS name, it is a mnemonic, and indicates that this sequential
data store should be placed in the knowledge base table HSURDINT rather than residing
on disk. In this case, the mnemonic sequential data store value is placed in the
HSURDINT.INTNAME column, so the contents of the data store within HSURDINT can be
easily identified in further processing.

Export Combined Data Elements Information
Complete the values listed in the Secondary Options window for the Export Combined Data Elements
Information job as shown below:

Sequential
data store

Name of the data store containing the interface. Typically, it is a valid z/OS data store
name. If it is not a valid z/OS name, it is a mnemonic, and indicates that this sequential
data store should be placed in the knowledge base table HSURDINT rather than residing
on disk. In this case, the mnemonic sequential data store value is placed in the
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HSURDINT.INTNAME column, so the contents of the data store within HSURDINT can be
easily identified in further processing.
Note: You can use the Export Combined Data Elements Information job to export data from one Data
Express instance to another by configuring the external interface output to use an alternative data
store name and DB2 qualifier. To configure the external interface output, edit the UURXEX program
provided with Data Express.

Export Copybook Information
Complete the values listed in the Secondary Options window for the Export Copybook Information job
as shown below:

Sequential
data store

Name of the data store containing the interface. Typically, it is a valid z/OS data store
name. If it is not a valid z/OS name, it is a mnemonic, and indicates that this sequential
data store should be placed in the knowledge base table HSURDINT rather than residing
on disk. In this case, the mnemonic sequential data store value is placed in the
HSURDINT.INTNAME column, so the contents of the data store within HSURDINT can be
easily identified in further processing.

Note: You can use the Export Copybook Information job to export data from one Data Express
instance to another by configuring the external interface output to use an alternative copybook name
and library. To configure the external interface output, edit the UURXEX program provided with Data
Express.

Export Data Store Information
Complete the values listed in the Secondary Options window for the Export Data Store Information job
as shown below:

Sequential
data store
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Name of the data store containing the interface. Typically, it is a valid z/OS data store
name. If it is not a valid z/OS name, it is a mnemonic, and indicates that this sequential
data store should be placed in the knowledge base table HSURDINT rather than residing

on disk. In this case, the mnemonic sequential data store value is placed in the
HSURDINT.INTNAME column, so the contents of the data store within HSURDINT can be
easily identified in further processing.
Note: You can use the Export Data Store Information job to export data from one Data Express
instance to another by configuring the external interface output to use an alternative copybook name
and library, data store name, and DB2 qualifier. To configure the external interface output, edit the
UURXEX program provided with Data Express.

Export DB2 Table Information
Complete the values listed in the Secondary Options window for the Export DB2 Table Information job
as shown below:

Sequential
data store

Name of the data store containing the interface. Typically, it is a valid z/OS data store
name. If it is not a valid z/OS name, it is a mnemonic, and indicates that this sequential
data store should be placed in the knowledge base table HSURDINT rather than residing
on disk. In this case, the mnemonic sequential data store value is placed in the
HSURDINT.INTNAME column, so the contents of the data store within HSURDINT can be
easily identified in further processing.

Note: You can use the Export DB2 Table Information job to export data from one Data Express
instance to another by configuring the external interface output to use an alternative data store name
and DB2 qualifier. To configure the external interface output, edit the UURXEX program provided with
Data Express.

Export Methods Information
Complete the values listed in the Secondary Options window for the Export Methods Information job as
shown below:
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Group

The group you want to export.

Method

The method you want to export.

Sequential
data store

Name of the data store containing the interface. Typically, it is a valid z/OS data store
name. If it is not a valid z/OS name, it is a mnemonic, and indicates that this sequential
data store should be placed in the knowledge base table HSURDINT rather than
residing on disk. In this case, the mnemonic sequential data store value is placed in the
HSURDINT.INTNAME column, so the contents of the data store within HSURDINT can
be easily identified in further processing.

Note: You can use the Export Methods Information job to export data from one Data Express instance
to another by configuring the external interface output to use an alternative data store name and DB2
qualifier. To configure the external interface output, edit the UURXEX program provided with Data
Express.

Export Multi-format Data Stores Information
Complete the values listed in the Secondary Options window for the Export Multi-format Data Stores
Information job as shown below:

Sequential
data store
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Name of the data store containing the interface. Typically, it is a valid z/OS data store
name. If it is not a valid z/OS name, it is a mnemonic, and indicates that this sequential
data store should be placed in the knowledge base table HSURDINT rather than residing
on disk. In this case, the mnemonic sequential data store value is placed in the
HSURDINT.INTNAME column, so the contents of the data store within HSURDINT can be
easily identified in further processing.

Note: You can use the Export Multi-format Data Stores Information job to export data from one Data
Express instance to another by configuring the external interface output to use an alternative data
store name and DB2 qualifier. To configure the external interface output, edit the UURXEX program
provided with Data Express.

Load Distributed Sampling Results job
Complete the values listed in the Secondary Options window for the Load Distributed Sampling
Results job as shown below:

This job can be used when knowledge base is DB2 in order to load sampling result into knowledge base
via a batch job running on MVS. In this way the sampling runs on distributed environment, it generates a
log file containing sampling result, this log file should be moved on MVS (in a FB sequential file with record
length equal to 80) and it is processed by the Load Distributed Sampling Result job. The parameter for
this job is the sampling data set name (the sequential file containing sampling result).

Import Classes Information
Complete the values listed in the Secondary Options window for the Import Classes Information job as
shown below:

Sequential
data store

Name of the data store containing the interface. Typically, it is a valid z/OS data store
name. If it is not a valid z/OS name, it is a mnemonic, and indicates that this sequential
data store should be placed in the knowledge base table HSURDINT rather than residing
on disk. In this case, the mnemonic sequential data store value is placed in the
HSURDINT.INTNAME column, so the contents of the data store within HSURDINT can be
easily identified in further processing.

Import Classification from Data Dictionary job
Complete the values listed in the Secondary Options window for the Import Classification from Data
Dictionary job as shown below:

Front End Guide

| 65

Dictionary Interface

The dictionary interface name.

Import Classification from Referential Integrity job
Complete the values listed in the Secondary Options window for the Import Classification from
Referential Integrity job as shown below:

Referential Integrity Interface

Referential Integrity Interface name.

Import Combined Data Elements Information
Complete the values listed in the Secondary Options window for the Import Combined Data Elements
Information job as shown below:

Sequential
data store
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Name of the data store containing the interface. Typically, it is a valid z/OS data store
name. If it is not a valid z/OS name, it is a mnemonic, and indicates that this sequential
data store should be placed in the knowledge base table HSURDINT rather than residing
on disk. In this case, the mnemonic sequential data store value is placed in the
HSURDINT.INTNAME column, so the contents of the data store within HSURDINT can be
easily identified in further processing.

Import Method from Referential Integrity job
Complete the values listed in the Secondary Options window for the Import Method from Referential
Integrity job as shown below:

Referential integrity interface Referential Integrity Interface name.
Method

Name of a particular method or all methods.

Method text

Method description.

Class

Name of the class.

Update method

Check this to update an existing method, adding a new relationship
between data stores.

Import Methods Information
Complete the values listed in the Secondary Options window for the Import Methods Information job as
shown below:

Group

The group you want to import.

Method

The method you want to import.

Sequential
data store

Name of the data store containing the interface. Typically, it is a valid z/OS data store
name. If it is not a valid z/OS name, it is a mnemonic, and indicates that this sequential
data store should be placed in the knowledge base table HSURDINT rather than
residing on disk. In this case, the mnemonic sequential data store value is placed in the
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HSURDINT.INTNAME column, so the contents of the data store within HSURDINT can
be easily identified in further processing.

Import Multi-format Data Stores Information
Complete the values listed in the Secondary Options window for the Import Multi-format Data Stores
Information job as shown below:

Sequential
data store

Name of the data store containing the interface. Typically, it is a valid z/OS data store
name. If it is not a valid z/OS name, it is a mnemonic, and indicates that this sequential
data store should be placed in the knowledge base table HSURDINT rather than residing
on disk. In this case, the mnemonic sequential data store value is placed in the
HSURDINT.INTNAME column, so the contents of the data store within HSURDINT can be
easily identified in further processing.

Load Copy Information from External Interface job
Complete the values listed in the Secondary Options window for the Load Copy Information from
External Interface job as shown below:

Sequential file

Name of the sequential file on z/OS.

Load DB2 Table Information by Unload job
This job can be used before creating the extraction method. Be sure to specify a sequential unload of the
files and insert the process identifier for reading the file.
Complete the values listed in the Secondary Options window for the Load DB2 Table Information by
Unload job as shown below:
Insert the fields related to the sequential unload:
SYSPUNCH or DCLGEN name The name of the SYSPUNCH or DCLGEN file.
Unload data set name
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The name of the unload data set.

Process identifier

Process identifier used for the management of DB2 files with sequential
access.

Application identifier

Application identifier (if applicable).

For the z/OS solution, the only DB2 utility for the UNLOAD of table supported by Data Express is
DSNTIAUL or a direct JCL Unload with some limitations.
The following is a sample of the JCL:
“//DSURUNL2 JOB (00001),DMP,MSGCLASS=A,CLASS=1,NOTIFY=&SYSUID
//JOBLIB
DD DISP=SHR,DSN=DSN810.SDSNLOAD
//* ---------------------------------------------------------------- *
//UNLOAD3 EXEC PGM=IKJEFT01,DYNAMNBR=20
//STEPLIB DD DISP=SHR,DSN=DSN810.SDSNLOAD
//SYSTSPRT DD SYSOUT=*
//SYSPRINT DD SYSOUT=*
//SYSUDUMP DD SYSOUT=*
//SYSTSIN DD *
DSN SYSTEM(HADB)
RUN PROGRAM(DSNTIAUL) PLAN(DSNTIB81) LIB('DB2HAL.RUNLIB.LOAD')
//SYSREC00 DD DSN=URADAR.RUMYANA.SYSREC.D44444,
//
DISP=(NEW,CATLG,CATLG),
//
UNIT=SYSDA,SPACE=(TRK,(30,30))
//SYSPUNCH DD DSN=URADAR.RUMYANA.SYSPUN(D44444),
//
DISP=OLD
//SYSPRINT DD SYSOUT=*
//SYSIN
DD *
"D444444444444444444444444444444444444444444444444444444444
4444444444444444444444444444444444444444444444444444444444444444444444".
"D4444444444444444444444444444444444444444444444444444444444444444444444
444444444444444444444444444444444444444444444444444444444"
“
The following is a sample SYSPUNCH generated by the JCL described above:
“
LOAD DATA LOG NO INDDN SYSREC00 INTO TABLE
"D4444444444444444444444444444444444444444444444444444444444444444
444444444444444444444444444444444444444444444444444444444444444"."D44444
444444444444444444444444444444444444444444444444444444444444444444444444
44444444444444444444444444444444444444444444444444"
(
CARD_TYPE
POSITION(
1
)
CHAR(
1) ,
CARD_NUM
POSITION(
2
)
CHAR(
16) ,
ACCOUNT_OPER
POSITION(
18:
30)
DECIMAL
,
DATE_OPRT
POSITION(
31
)
CHAR(
8)
)
“
The following is a sample of the UNLOAD's JCL:
“//DSURUNL8 JOB (00001),DMP,MSGCLASS=A,CLASS=1,NOTIFY=&SYSUID
//JOBLIB
DD DISP=SHR,DSN=DSN810.SDSNLOAD
//* ---------------------------------------------------------------- *
//UNLOAD3 EXEC DSNUPROC,SYSTEM=HADB,UID='UNLOA1',
// UTPROC=''
//STEPLIB DD DISP=SHR,DSN=DSN810.SDSNLOAD
//SYSREC
DD DSN=URADAR.STEFANO.SYSREC.PIPPO,
//
DISP=(NEW,CATLG,CATLG),
//
UNIT=SYSDA,SPACE=(TRK,(30,30))
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//SYSPUNCH DD DSN=URADAR.STEFANO.SYSPUNCH.PIPPO,
//
DISP=(NEW,CATLG,CATLG),
//
UNIT=SYSDA,SPACE=(TRK,(1,1))
//SYSIN
DD *
UNLOAD FROM TABLE
NRT40NAME_TESTXM.TEST_LENGTH37CHARACT
HEADER NONE
“
The previous JCl is supported only for those tables having owner name and or table name not longer than
40 character.
The following SYSPUNCH sample is the only format generated by the JCL described above which is
supported by Data Express:
“
LOAD DATA INDDN SYSREC
LOG NO RESUME YES
EBCDIC CCSID(00037,00000,00000)
INTO TABLE
"NRT40NAME_TESTXM".
"TEST_LENGTH37CHARACT"
( "CODCUS"
POSITION( 00001:00010) CHAR(00010)
, "NAME"
POSITION( 00011:00040) CHAR(00030)
, "SURNAME"
POSITION( 00041:00070) CHAR(00030)
)
“
The following SYSPUNCH sample is the BMC UNLOAD format which is supported by Data Express:
LOAD DATA LOG NO INDDN SYSREC00 INTO TABLE
OWURSVIL.BMCTAB99
(
CODCUS99
POSITION(
1:
5)
DECIMAL
NULLIF BMC_NULL1=X'6F',
BMC_NULL1 POSITION(6) CHAR (1),
NAME99
POSITION(
7:
26)
CHAR (20)
NULLIF BMC_NULL2=X'6F',
BMC_NULL2 POSITION(27) CHAR (1),
SURNAME99
POSITION(
28:
47)
CHAR (20)
NULLIF BMC_NULL3=X'6F',
BMC_NULL3 POSITION(48) CHAR (1),
ADDRESS99
POSITION(
49:
88)
CHAR (20)
NULLIF BMC_NULL4=X'6F',
BMC_NULL4 POSITION(89) CHAR (1),
The following SYSPUNCH sample is a format generated by the JCL described above which is not
supported by Data Express:
“
LOAD DATA INDDN SYSREC
LOG NO RESUME YES
EBCDIC CCSID(00037,00000,00000)
SORTKEYS
72
INTO TABLE
"D444444444444444444444444444444444444444" ||
"4444444444444444444444444444444444444444" ||
"4444444444444444444444444444444444444444" ||
"44444444".
"D444444444444444444444444444444444444444" ||
"4444444444444444444444444444444444444444" ||
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"4444444444444444444444444444444444444444" ||
"44444444"
( "CARD_TYPE"
POSITION( 00001:00001) CHAR(00001)
, "CARD_NUM"
POSITION( 00002:00017) CHAR(00016)
, "ACCOUNT_OPER"
POSITION( 00018:00030) DECIMAL
, "DATE_OPRT"
POSITION( 00031:00038) CHAR(00008)
)
“

Load DL/I Database Information job
This job can be used before creating the extraction method. Be sure to specify a sequential unload of the
files and insert the process identifier for reading the file.
Complete the values listed in the Secondary Options window for the Load DL/I Database Information
job as shown below:

DBD name

The name of the DL/I database.

Unload data set name The name of the unload data set.
Process identifier

Process identifier used for the management of DL/I files with sequential access.

Application identifier Application identifier (if applicable).
Select Option

Select this option if partial unload of the multi format segments will be performed.
In this case, define the Segment Name and Format Selector of the segments
you want to be unloaded.
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Load Data Store Information from External Interface job
Complete the values listed in the Secondary Options window for the Load Data Store Information from
External Interface job as shown below:

Sequential file

Name of the sequential file on z/OS.

Note: Before starting the job, all copybooks described in the sequential file must be already loaded in
the product.

Load SEQ/GDG Data Set Information job
Complete the values listed in the Secondary Options window for the Load SEQ/GDG Data Set
Information job as shown below:
Data set name

Name of the data set on z/OS.

Short DSN

Short name of the data set.

Unload data set name Name of the unload data set. This is for the z/OS environment only. It can be
different from the original name loaded into the Knowledge Base. To do this, the
process ID associated with the elaboration should be created with characteristics
for an Unload File Access. For example, GENUN.
Process identifier

The routines needed by the product to read, analyze and interpret the data of the
processed files.

Format selector

Exit routine for recognizing formats.

Application identifier Application identifier (if applicable).

Load VSAM Data Set Information job
Complete the values listed in the Secondary Options window for the Load VSAM Data Set Information
job as shown below:
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VSAM data set name

Name of the VSAM data set on z/OS.

Short DSN

Short name of the data set.

Unload data set name Name of the unload data set.
Process identifier

The routines needed by the product to read, analyze and interpret the data of the
processed files.

Format selector

Exit routine for recognizing formats.

Application identifier Application identifier (if applicable).

Custom jobs
Using Work with Jobs, you can create custom jobs that can be submitted by the z/OS engine just as the
default preloaded jobs are submitted. To so this, Data Express provides a wizard into which you put a job
name, the name of the MVS skeleton used to execute the JCL, a job description, and job parameters.
You can choose the job parameters from a list that enables you to select the scope of various Data Express
operations. The list contains the following parameters:
Machine ID
Company
Copybook PDS
Copybook name
Application ID
DB owner or DL/I DBD
Data store type
Data store name
Data store version
Record format
Method
Group
Code
In addition, you can create custom parameters. You must supply the following information for each custom
parameter you create:
Name
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Description
Length
Type (alphanumeric or numeric)

New Custom Query Wizard
The New Custom Query Wizard guides you through creating custom views for the data stores in the
Knowledge Base.

Starting the New Custom Query wizard
1.
To start the New Custom Query Wizard, click

2.
3.
4.
5.

.

Note: To return to the Set Name&Bitmap screen and discard any changes, click Restart. To exit
the wizard and discard any changes, click Abort.
Specify the query name.
Select the image you want to use by clicking the Button Bitmap image.
Click Next.
Select the fields to be displayed in the custom query.
Note: Click Finish if you do not want to set a filter. The function proceeds with creating the view.

6. Click Next.
7. Filter results for the custom query by selecting information for the following fields:
•
•
•
•
•

Machine ID
Company name
Application ID
DB2 Owner DL/1 DBD
File type

Note: Click Finish if you do not want to set any other filter. The function proceeds with creating the
view.
8. Click Next.
9. Select the desired filters and click Add.
Note: Click Finish if you do not want to sort the query. The function proceeds with creating the
view.
10.Click Next.
11.Set the order by which you want to display data.
12.Choose one or more fields from the List of available data elements list and the Sort Mode section.
Note: Click Finish if you do not want to set the query as default. The function proceeds with
creating the view.
13.Click Next.
14.If desired, check Set this query as default view on startup to specify the query you created is used
as the default.
15.Click Finish.

Options
Data Express can be customized to meet the requirements for different users.
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This section describes the available options in the Data Builder and Data Subset Extraction modules. For
available options in the Data Masking module, see the Data Masking Guide.

Window contents
Options can be edited in the Options window. To display the window, click Tools > Options.

General
The General page has the following fields:
Help options
Help language The language used for online help. The Help language list contains the
languages available on your PC.
Security options
Save user and password An indicator of whether or not you want to save your user ID and password
information for the current database connection.

Filter settings
The Filter Settings page allows the scope of the filters configured in the Work with Data Stores area to
be selected.
The Filter Settings page has the following fields:
Filter Scope Options
Filter on current TabSheet This filter is valid for the current sheet, so that the filter is applied if the tree
node is changed, but is not applied if the sheet is changed.
Filter on all TabSheets This filter is valid for the nodes of the tree, so that the filter is not applied
when the tree node is changed.
Data Store Behavior Options
Show filter before loading the data Allows the filter to be shown before loading the data.
Clear All Existing Filters

Deletes all existing filters.

Confirmation messages
The Confirmation Messages page lets you set specific work modes. The Confirmation Messages page
has the following fields:
Assign the example data element to all companies – (Yes, No, Ask).
Clean Class/es assigned to the selected data elements – (Yes, Ask).

Confirmation routine name
The Confirmation Routine Names page lets you set specific work modes. The Confirmation Routine
Names page has the following fields:
Check the existence of masking/subsetting routine – (Yes, No, Ask).

Value Yes means that in any place you can specify a routine, you can only choose a routine inserted using
Work with Routines.
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Server information
The Server Information page allows the connection options for Data Express kbde-Server to be displayed
and modified.
Note: The Server Information page is only displayed in Client/Server mode use of the Data Builder
module.
The Server Information page has the following fields:
Server Information
IP Address The IP address of the NT server (required for Socket and DCom
connections).
Port Number The port number assigned to the Borland Socket Server validity when the
tree node is changed (required for Socket connections).
URL The URL to identify the httpsrvr.DLL file installed on the server
machine (required for HTTP connections).
Type of connection (Socket, DCom, HTTP).

Connection options

Available operations
The buttons at the bottom of the Options window are:
OK

Saves any changes that have not been applied and closes the window.

Cancel Cancel any changes applied. Any actions confirmed with Apply cannot be restored with Cancel
but must be entered and confirmed again.
Apply

Confirms the changes.

File Properties
The Properties - File window is a tabbed view that displays all attributes for a selected data store.
To access the Properties - File window, click
(Data Store Properties) from the Work with Data
Stores area, or right-click the appropriate table from the List of Data Stores and click Data Store
Properties.

Window contents
This section describes each tab of the Properties - File window.

General attributes page
The fields on the General Attributes page are:
Data store description Description of the data store.
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Application ID

Identifier (if it exists) of the application area that the data store belongs to.

Process ID

Process Identifier.

Format selector

Exit routine for data-store format recognition.

Record length

Length (in bytes) of the record.

| Front End Guide

Data store name

Name of the data store.

Data store type

Type of data store, for example, DB2, VSAM, DL/I, GDG, SEQ, ODBC, or ORA.

Data store ver

Version of the data store.

Sampling frequency

Frequency (for example, daily or monthly) of sampling of the table fields for
which the distribution of values is desired. (Only applicable for Data Express for
z/OS.)

Register Tables

Indicator of whether the data store is a register table.

System page
The fields on the System page are:
Machine ID

Identifier of the machine.

Company name

Name of the company.

Object attributes page
The fields on the Object Attributes page are:
Data store type

Type of table, for example, DB2, VSAM, DL/I, GDG, SEQ, ODBC, ORA.

Data store name

Name of the data store.

Data store description

Description of the data store.

Application ID

Identifier (if it exists) of the application area that the data store belongs to.

Record length

Length (in bytes) of the record.

Record format

Name of the record format.

Format selector

Exit routine for table format recognition.

Number of records

Number of records contained in the data store.

Analyzed records

Number of analyzed records.

Database name

Name of the database.

Tablespace name

Name of the tablespace.

Object ID

Object identifier.

Dates page
The fields on the Dates page are:
Date of analysis

Date of the analysis carried out on the table.

Date of last calculation Date of the last recalculation carried out on the table.
Date of last sample

Date of the last calculation of the distribution of values of the table fields
involved in the process.

Associated Copybook page
The Associated Copybook page is only available in the Data Express for z/OS solution.
The fields on the Associated Copybook page are:
Copy PDS

Partitioned data set to which the copybook assigned to the data store belongs.
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Copybook name

Name of the copybook assigned to the data store.

I/O area name

Name of the area present on the copybook which describes the layout of the data
store.

I/O Area Progressive Progressive number of the area within the copybook associated with the data
store.
Information provider Identifies who carried out the association of the copybook with the data store.
Manual indicates the user did this manually. Automatic indicates the assignment
was done automatically by the analysis carried out Data Express.
Note: The Associated Copybook page is not visible for DB2 tables.

Available operations
The buttons at the bottom of the Properties – File window are:
Change Enables control and goes into edit mode.
Note: This button is only available on the General Attributes page.
OK

Saves any changes that have not been applied and closes the window.

Cancel Cancels any changes applied to the data store properties and closes the window. Any actions
confirmed with Apply cannot be restored with Cancel but must be entered and confirmed
again.

Filter by Data Store
The Filter-Data Stores window enables you to apply a filter definition to the data store list so you can
make a partial selection of information and carry out a one-off analysis.
Various types of selection can be applied and are applicable to different requirements. For example:
•
•
•

A very large application might be divided by Application ID values so each manager could carry out an
analysis on his area of responsibility.
Anyone who uses a prefix for distinguishing data store belonging to an area could use a partial selection
on the data store name.
Anyone who uses a different qualifier (for example, Owner) for each area of responsibility of data stores
could carry out a selection by library.

To access this function, click

(Filter-Data Stores) from the Work with Data Stores area.

Window contents
This section describes the fields listed on each page of the Filter-Data Stores window.

System page
The fields on the System page are:
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Machine ID

Selects by machine ID.

Company

Selects by company name.
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Object page
The fields on the Object page are:
Selects data stores based on the application area they belong to.

Application ID

DB2 owner, DL/I DBD Selects by (DB2) owner or by database description (DL/I).For other types of data
stores, the generic term *ALL can be used.
Data store type

Selects by data store type distinguishing between DB2, VSAM, DL/I, Sequential
(SEQ), GDG, ODBC, or ORA.

Data store name

Selects by data store name.

Data store version

Selects by data store version.

Analyzed

Selects by state of analysis of the data store. The possible values are: (Yes, No,
and *ALL).

Record page
The fields on the Record page are:
Record
format

Selects by record format.

Record
length

Selects data stores with record layout length within a range of values. If only one of the
two limits of the interval is specified all of the values greater than the start value (if the end
value is not specified) or less than the end value (if the start value is not specified) are
extracted.

Number of
records

Selects data stores with the number of records within a range of values. If only one of the
two limits of the interval is specified all of the values greater than the start value (if the end
value is not specified) or less than the end value (if the start value is not specified) are
extracted.

Records
analyzed

Selects data stores with the number of records, which have been analyzed within a range
of values. If only one of the two limits of the interval is specified, all of the values greater
than the start value (if the end value is not specified) or less than the end value (if the
start value is not specified) are extracted.

Dates page
The fields on the Dates page are:
Selects data stores with a given analysis date.

Date of analysis

Date of last calculation Selects data stores with a given date of the last recalculation.
Selects data stores with a given date of the last calculation of the distribution of
values.

Date of last sample

Associated Copybook page
The fields on the Associated Copybook page are:
Copybook PDS

Selects by partitioned data set the copybooks assigned to the data stores.

Copybook name

Selects by the name of copybooks assigned to the data stores.

Scheduling page
The Scheduling page only applies to Data Express for z/OS.
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The field on the Scheduling page is:
Sampling frequency Selects by frequency of sampling (for example, daily or monthly) of the data store
data elements.

Available operations
The buttons at the bottom of the Filter-Data Stores window are:
Clear All Clears all modifications made to the selected filter.
Settings Sets any modifications made to the selected filter.
OK

Saves any changes made to the selected filter and closes the window.

Cancel

Cancels any changes made to the selected filter and closes the window. Any actions confirmed
with Apply cannot be restored with Cancel but must be entered and confirmed again.

Compare Layouts - Copybook
The Compare Layouts– Copybook window lets you check that the calculated association is correct, by
checking the byte-by-byte congruence of the data element layout with an associated copybook.
Note: The Compare Layouts– Copybook window is not applicable for distributed data stores.
Data Express uses an association algorithm to determine the list of compatible copybooks (that describe its
trace) for each data store. The association algorithm is based on:
•
•

Compatibility of length between data store and copybook.
Byte-by-byte congruence between the data type of the data store and copybook traces.

The information for copybook bytes is obtained from the analysis of the source of the same copybook. The
information for file bytes is obtained during the file analysis on the basis of the congruence of the values
found within the records, their positions being equal.
Each byte, depending on its type, has a specific hexadecimal content. The evaluation of the congruence
between the copybook and the file bytes is based on an algorithm comparing the copybook byte with the
hexadecimal content of the corresponding file byte.
To access this function, click

(Compare Layouts – Copybook) from the Work with Data Store area.

Window contents
This section describes the fields listed in the Compare Layouts – Copybook window.
The upper part of the window shows two frames containing the file and the selected copybook attributes.
Selecting the assigned copybook node on the left-hand side displays a list of compatible copybooks.
Field

Description

Data Store
Machine ID Identifier of machine that the data store belongs to.
Company Identifier of company that the data store belongs to.
Name Name of the data store.
Record format Record format name.
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Field

Description
Record length Length of the data store record.

Selected Copybook
Machine ID Identifier of machine that the data store belongs to.
Company Identifier of company that the data store belongs to.
PDFS Partitioned data set that the selected copybook belongs
to.
Name Name of the selected copybook.
Copy Length Length of the selected copybook.
I/O Area Name Name of the I/O area identified within the copybook.
Prog I/O area progressive number.
Byte-by-Byte Congruence
Byte Position Position of the byte in the data store layout.
File Byte Data type for the byte in the data store layout. Available
values: Alphanumeric, Binary, Filler, Low-value, Packed
Central, Packed Final Unsigned, Packed Final Signed,
Space, Zoned Unsigned, Zoned Signed, and Bit.
Confidence Hypothesis confidence for the byte in the data store
layout.
Copybook byte The byte type of the selected copybook. Available values:
Alphanumeric, Binary, Filler, Low-value, Packed Central,
Packed Final Unsigned, Packed Final Signed, Space,
Zoned Unsigned, Zoned Signed, and Bit.
Green disk
icon

Full compatibility, the copybook byte is
the same as the file byte.

Half green,
half yellow
disk icon

Partial compatibility with high
reliability.

Yellow disk
icon

Partial compatibility with low reliability.
The file bytes always set to spaces
and/or the copybook bytes included in
filler areas also belong to this
category.

Red disk
icon

Total incongruence between the
copybook byte and the file byte.

Level of compatibility indicators
Copy Bytes Matching Percentage of bytes compatible between data store and
copybook with respect to the length of the data store
layout.
Confidence Estimate of the level of similarity between the proposed
file byte value and the corresponding file byte content
considering the file analysis only.
Compatible Copybooks Displays the list of all the copies with the same level of
compatibility with the data store.
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Field

Description
All Copies (Filtered) Displays all the copybooks belonging to the environment
selected on the basis of the specified associated filters.

Filter on All Copybooks - General Tab
Machine ID Allows selection by machine identifier.
Company
Filter on All Copybooks - Copybook Attributes Tab
Name Allows selection by company name.
Tolerance % If a value different from 0 (zero) is set, it allows you to
select copies from the environment whose length differs
from that of the file layout by the set percentage value. By
default, the parameter is set to 0. This implies that copies
whose length coincides with that of the file are displayed.
Value 100 allows you to select all the copybooks
belonging to the Machine ID and to the company selected
on the General page.

Available operations
The buttons listed in the Compare Layouts – Copybook window are described below:
Description

Button
Data Store

Compare Displays a list showing the byte-per-byte compatibility
between data store and selected copybook and the Copy
Bytes Matching and Confidence percentages.
Assign Assigns the copybook to the data store.
Delete Deletes the copybook-data store association.
(Graph)

Opens a window including a pie chart of the distribution of
the byte compatibility between data store and selected
copybook.

Filter
Clear Filters Returns all the conditions included in the window to their
initial value.
Apply Filters Applies the selected filters.
Close Closes the window.

Sample Graph - Data Sampling
The Data Sampling function can be used to display a pie chart of the distribution of values of a data store
data element, highlighting the values that occur most often within the data element.
To access the Sample Graph window from the Data Sampling function:
1.

Click the
tab or
(View Data Stores by Sampling) on the toolbar.
2. Right-click the appropriate table and click Open Selected Data Store.
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3. Right-click the appropriate table in the List of Data Elements and click Show In Sampling.
4. Select the appropriate field in the List of Sample Analysis of the Selected Data Store Field, and
either click
(Sample Graph of the Selected Data Element) or right-click to display the context
menu.
5. Click Sample Graph of the Selected Data Element.

Window contents
This section describes the contents of the Sample Graph window.
The pie chart shows the values that occur most often.
On the right-hand side, the legend shows how many times a certain value appears and the color of its
corresponding segment in the graph. The width of each segment is proportional to the number of records
with that value.
The fields and buttons in the Sample Graph window are:
Number of Different
Values

Number of different values estimated for this field.

Show the x Values with
Major Occurrence

Number of largest occurring different values. By default, this value is 5. All
the other values are included in the segment labeled as OTHER. This value
can be increased or decreased.

Apply

Applies the changed value in the field Values with Major Occurrence and
shows the graph with the changed values immediately.

OK

Closes the window.

Show Synthetic Data Element Contents
The function of the Show Synthetic Data Element Contents window is to obtain a concise graphical
representation of data element content. The representation of the content depends on the nature of the
data element.
•

•

The values of the numeric data elements are divided into homogeneous groups that are differentiated
by the value of their first digit and by the number of digits they contain. This description preserves the
general representation of the distribution of the values throughout the data element.
The values of the alphanumeric data elements are divided according to various criteria:
•
•
•
•

First character
Value length
Presence of numeric characters only
Presence of alphabetical characters only

The number of values belonging to each class is stored for all of these criteria. All this information allows
you to preserve many of the data elements content properties.
To access the Show Synthetic Data Element Contents window, from the main window, select the
(Show Synthetic Data Elements). Or, right-click to display the
appropriate data store and either click
context menu, then click Show Synthetic Data Element Contents.

Window contents
This section describes the fields listed in the Show Synthetic Data Element Contents window.
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The tree of the data store data elements for which the sampling has been carried out is displayed on the
left-hand side of the window. If you select one of these data elements, its concise content in the form of a
table and graph is highlighted on the right-hand side of the window.
Control

Description

Field:
Machine ID

Identifier of machine that the data store belongs to.

Company

Identifier of company that the data store belongs to.

Name

Name of the data store.

Record format

Name of the record format.

Data store type

Type of data store.

Number of records

Number of records in the data store.

Recalculation date

Reference sampling date.

Button:
Apply

Applies the filter on a recalculation date.

Close

Closes the window.

Sample or Graph

Shows the synthetic data element content in the form of a
value list and of a graph at the bottom of the window.

Sort or Normal

Orders the sampling density values in decreasing order
(valid for numeric data elements only).

Filter

Opens a window where you can apply filters to the data
element selection.

Work with Copybooks
The Work with Copybooks area provides information on the COBOL copies and PL/I includes loaded in
the Data Express Knowledge Base.
Note: The languages handled by Data Express are COBOL, PL/I, and DCLGEN. Any sources written
in different languages are loaded as unhandled languages. If you want to avoid loading unrecognized
sources, choose the relevant option.
To access the Work with Copybooks area, click

(Work with Copybooks) on the toolbar.

Window contents
This section describes the columns listed in the Work with Copybooks area and Work with a Selected
Copybook window.
Work with Copybooks
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Copybook Name

Name of the COBOL copybook or of the PL/I include.

Copybook PDS

Name of the partitioned data set that contains the COBOL copybook or PL/I
include file.

Machine ID

Identifier of the machine that the copybook belongs to.

Company

Identifier of the company that the copybook belongs to.
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I/O area name

Name of the I/O area identified within the copybook.

IO Area Prog

I/O area progressive number determined by incongruent redefinitions of the
area.

Copy Text

The copybook text.

Analysis Flag

Indicator of whether the copybook has been analyzed.

Bad Copy Flag

Indicator of whether there is additional information on the copybooks.

Type of Anomaly

MIX (1)

Statements have been identified within the copybook.

N01 (2)

The 01 level of the I/O area has not been identified.

MUL (3)

More than an I/O area has been identified within the copybook.

NFR (4)

No I/O areas have been identified within the copybook.

ERR (5)

An error has been identified during the analysis.

Copybook language:

Language

CBL

COBOL copy

PLI

PL/I include

DGC

COBOL dclgen

DGP

PL/I dclgen

DDL

DDL

N/A

Non-handled language

Record Length

Length of the copybook records.

Number of Fields

Number of fields in the copybook/include file.

Number of Packed
Fields

Number of packed fields in the copybook/include file.

Number of Binary Fields Number of binary fields in the copybook/include file.
Associated Copy

Indicator of whether the I/O area has been associated with a data store.

Work with Selected Copybook
Field name

Name of the field.

Displacement

Field offset at the beginning of the I/O area.

Field Level

Definition level of the field within the COBOL copybook or PL/I include.

Type

Data type included in the field:
(B)

Binary numeric type.

(F)

Floating point numeric type.

(N)

Zoned numeric type.

(P)

Packed numeric type.

(X)

Alphanumeric type.

(Z)

Edited type.

(A)

Pointer type.

Front End Guide

| 85

Length

Length of the field in bytes.

Integer

Number of integer digits within the numeric field.

Decimal

Number of decimal digits within the numeric field.

Sign

Indicator of whether the numeric field is signed (Yes or No).

OCCURS Level Indicator of whether the field is an array.
Indicator of whether the field belongs to a group (Yes or No).

Group
Buttons
Refresh

Refreshes the screen.
Open selected Copy

Opens another menu with detailed information about the selected
copybook/include file and fields contained in it.

Delete Selected Copybook Deletes the selected copybook.

Distributed Loader
The Distributed Loader is a utility that lets you load and map information from source data stores to your
Knowledge Base as part of the Data Inventory process. The Knowledge Base can exist either on Windows
or z/OS.
Note:
•
•

For data stores that you will access using the Oracle Extension, you must configure a BDE alias
for your data store.
For data stores that you will access using the ODBC Extension, only an ODBC DSN is required.

For more information, see the Getting Started with Distributed Data Stores guide.
You can use the Load from Database functionality if you have a connection configured to access your
data store from your Windows machine. Otherwise, you must use the Load from File functionality.
To access the Distributed Loader window, click

from the main window.

Load from database
Begin by selecting the Load from Database tab. In Data Express for Distributed Systems, you will see an
import checkbox for referential integrity labeled: Load Referential Integrity. This provides the ability to load
your referential integrity information into the Windows Knowledge Base, in addition to standard schema
information about your tables. You are now ready to import your referential integrity classes. See the
Getting Started with Distributed Data Stores guide for more information.
In Data Express for z/OS, an export checkbox labeled Export Referential Integrity is provided instead. In
this environment, a file that contains referential information is created for you. Once this file is transferred to
the mainframe, you can load and import your referential integrity classes. See the Getting Started with
Distributed Data Stores guide for more information.
Standard schema information about your distributed data store’s tables is automatically loaded in the z/OS
knowledge base. You can logically reduce the amount of information you wish to load by specifying the
name of a schema in the Schema field. Otherwise, you leave this field blank and the Distributed Loader
retrieves and loads all the information about all the schemas in the data store.
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Load from file
Begin by selecting the Load from File tab. In Data Express for Distributed Systems, two files can be used
as input to the load process. The first file contains information about your tables, columns, and indexes.
The second optional file contains information about your data store’s referential integrity.
In Data Express for z/OS, only the file that contains information about your tables, columns, and indexes
can be used. For a z/OS Knowledge Base, your referential integrity information gets loaded into the
Knowledge Base while executing the Import Classification from Referential Integrity job.
The files used as input by the Distributed Loader are created by the Extension Technology utility:
dxegenloadfile. Note that this utility will create both files. So, if you are using Data Express for z/OS, the
referential integrity file created is used as input to the Import Classification from Referential Integrity
job.
For more information, see the Getting Started with Distributed Data Stores guide.

Appendix A. Standard Mode
This appendix shows you how to prepare a working environment (or project) before using the Data Builder
module.
The Standard configuration enables you to access data on your system in different ways. The database
engine is Borland Database Engine (BDE) 5.01, which you install after you complete your Data Express
installation on Windows.
Note: The Data Express for Distributed Systems solution is installed as standard mode. For Data
Express for z/OS, you can install the product in standard mode if you choose.
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Architecture

BDE is inserted on another layer, the Borland SQL Links layer, which is installed together with BDE.
Connection to a database involves the creation of a database alias, which is a link to a database through a
DB2 SQL Links database driver. The database alias is created from BDE Administrator.
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Database connection prerequisite
Before opening the project with Data Express, you must create a database alias that establishes a
connection to the database.

DB2 database alias creation
Before you can create a DB2 database alias, you must have an IBM Client Application Enabler, and you
must have already cataloged all databases you want to access.
Notes:
•
•

The connection to the OS/390 system cannot be established through an ODBC DB2 database
alias but only through a DB2 database alias (that is, only through SQL Links).
If you are using Data Express on Windows Vista and User Access Control is enabled, you must
run the BDE Administrator utility as Administrator.

To create a DB2 database alias:
1. From Windows Control Panel, open BDE Administrator.
2. Click Object > New.
3. In the Database Driver Name list, click DB2.
4. Click OK to create the database alias.
5. Enter the database alias name in the All Database Aliases pane.
6. Click Object > Apply.
7. In the Definition of pane, click in the second column for DB2 DSN to display a list of schemas for DB2
databases that have been cataloged on the PC.
8. Select the appropriate database schema name, then click Object > Apply.
9. Verify the DB2 SQL Links Driver uses the correct library to access DB2 Connect 5.2. On the
Configuration page, select DB2 from /Configuration/Drivers/Native.
10.Click in the second column for DLL32 and ensure that SQLDB2V5 is selected.

Authorizations and privileges
When you open a project, you must enter the user ID and password to connect to the database server
where the project is located.
Data Express can save login information and use it for future connections to the same project, so you do
not need to enter your user ID and password every time you connect. However, not saving login information
is the default behavior.
The user ID used to establish the database connection must have read privileges on the following tables or
views:
•
•
•

All tables created by Data Express in the MVS, OS/390, or z/OS DB2 environment during the
installation phase.
SYSIBM.SYSTABLES
SYSIBM.SYSCOLUMNS

Appendix B. Client / Server Mode
This appendix shows how to configure access to the kbde-Server before using Data Express.
The actions listed in this section should be followed as a necessary first step before any serious use of
Data Builder .
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The Client/Server configuration provides access to the data resident on the MVS, OS/390, or z/OS system
through the kbde-Server. The intermediate layer of this architecture is Borland MIDAS 3 and the
connection to the server can be based on Socket, DCOM, or HTTP.
Note: You can only use client/server mode for Data Express for z/OS.

Architecture

Server connection prerequisite
Before opening a project in Data Express, you must define connection information for the kbde-Server.

Defining server connection information
This section describes how to define server connections for the Data Builder and Data Subset Extraction
modules.
Notes:
•
•

For more information about connection options to the kbde-Server, see Options.
Connection information is handled differently in the Data Masking module. For information about
defining server connections for Data Masking, see the Data Masking Guide.

To define connection information:
1. Click Tools > Options, then click the Server Information tab.
2. Specify the following information:
•
•
•
•
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IP Address – IP address of NT server (required for Socket and DCom).
Port Number – Port number assigned to Borland Socket Server (required for Socket).
URL – URL for the identification of the .dll installed on the server machine (required for HTTP).
Connection options – Type of connection desired.

3. Click OK to confirm.

Authorizations and privileges
Even though the connection to the MVS, OS/390, or z/OS system is established through the kbde-Server,
authentication information is requested at the client level. In other words, when you connect to a project
made available by the kbde-Server, you must enter a user ID and password to connect to the database
server where the project is located.
Data Express can save login information and use it for future connections to the same project, so you will
not need to enter your user ID and password every time you connect.
Note: Not selecting the Save user and password item from the Option window disables this feature.
The user ID used to establish the database connection must have read privileges on the following tables or
views:
•
•
•

All tables created by Data Express in the MVS, OS/390, or z/OS DB2 environment during the
installation phase.
SYSIBM.SYSTABLES
SYSIBM.SYSCOLUMN

Starting Server-side Executables as Windows Services
To establish a connection between Data Express modules and the Knowledge Base server, your DB2
server must be running the following server-side executables as services:
•
•

scktsrvr.exe - socket server
kbdeserver.exe - KBDE server

Data Express provides both executable files, which are located in the %ProgramFiles(x86)%\Micro
Focus\Data Express 4.0\kbde-Server directory by default.
You can configure Windows to start these executables automatically as services each time you start
Windows on the DB2 server. When both the socket and KBDE server services are started, the connection
is established automatically.
When the socket server service is started on the DB2 server, Windows starts the KBDE server service
automatically. Therefore, you need to configure only the socket server service to start automatically:
1. Set scktsrvr.exe to run as an administrator:
a. From Windows Explorer, change to the %ProgramFiles(x86)%\Micro Focus\Data Express
4.0\kbde-Server folder.
b. Right-click scktsrvr.exe; then select Properties.
c. Click the Compatibility tab.
d. Check Run this program as an administrator; then click OK.
2. At a Windows command prompt, change to the %ProgramFiles(x86)%\Micro Focus\Data
Express 4.0\kbde-Server directory.
3. Enter the following command:
scktsrvr.exe /install
4. Open Windows Services and start the Borland socket server, or reboot your machine.
Note: To remove these services:
1. Stop the Borland socket server service.
2. At a command prompt, change to the %ProgramFiles(x86)%\Micro Focus\Data Express
4.0\kbde-Server directory.
3. Enter the following command:
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scktsrvr.exe /uninstall
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